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Legal Notices
No part of this publication may be reproduced or transmitted in any form or by any means, electronic
or mechanical, including photocopy, recording, or any information storage or retrieval system, without
permission in writing from Bio-Rad Laboratories, Inc..

Bio-Rad reserves the right to modify its products and services at any time. This guide is subject to
change without notice. Although prepared to ensure accuracy, Bio-Rad assumes no liability for errors
or omissions, or for any damage resulting from the application or use of this information.

BIO-RAD and QUANTITY ONE are trademarks of Bio-Rad Laboratories, Inc. in certain jurisdictions.

All trademarks used herein are the property of their respective owner.

Copyright © 2020 by Bio-Rad Laboratories, Inc.. All rights reserved.

Technical Support
The Bio-Rad Technical Support department in the U.S. is open Monday through Friday, 5:00 AM to
5:00 PM, Pacific time.

Phone: 1-800-424-6723, option 2

Web: www.bio-rad.com

Email: Support@bio-rad.com (U.S./Canada Only)

For technical assistance outside the U.S. and Canada, contact your local technical support office.
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Chapter 1 Introduction
Image Lab software works with your imaging system to create a protocol — a reproducible,
automated, and time-saving workflow for imaging and analyzing gels and blots. You can create
protocols to ensure repeatable results, capture optimized image data, edit the analysis, and produce
customized reports.

On the Windows operating system, this version of Image Lab supports image acquisition on the
following instruments:

n ChemiDoc MP

n ChemiDoc XRS+

n Gel Doc EZ

n Gel Doc XR+

n GS-900 Calibrated Densitometer

On Mac operating systems, this version of Image Lab supports image acquisition only on
Gel Doc EZ and Gel Doc XR+ instruments. For detailed procedures about image acquisition settings
and running protocols, see the instrument guide for your imaging system.

Note: Bio-Rad standalone imagers acquire images using Image Lab Touch software, which
resides on the imagers. You can export images from these imagers and analyze them using
Image Lab on your computer.

Image Lab Security Edition is available to help organizations comply with US FDA 21 CFR Part 11
regulations.
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Chapter 2 Setting Up Image Lab Software
Image Lab Software can be installed on a computer running Microsoft Windows or a
Mac operating system. The amount of memory required for running Image Lab depends on the size of
the images you scan and analyze. Images scanned at high resolution can be quite large. For this
reason, Bio-Rad recommends that you archive images on a network file server or on removable
storage media.

Tip: Bio-Rad can provide an appropriate computer for use with your imaging system. Contact your
local Bio-Rad representative for details.

System Requirements

System Element Minimum Requirement

Operating system Microsoft Windows 7 (64-bit)

Microsoft Windows 10 (64-bit)

Mac OS X 10.14 or 10.15

Note: Applies only to the standard edition of Image
Lab Software. The security edition is not supported on
Mac operating systems.

Processor Intel Core i3 or equivalent

Hard disk space 60 GB

Memory (RAM) 4 GB

Ports for connecting
instrument

1 USB 2.0 port
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Before You Install Security Edition
During Image Lab installation, you can choose to install the standard edition or the security edition
Security Edition requires a license, which you enter as part of the installation.

Note: Security Edition is available for Windows computers only.

Important: To enable secure mode, Image Lab Administrator role privileges must be in place.
You must create the required groups and assign the Image Lab roles to users in those groups
before you install Image Lab software.

n For information on required Image Lab roles, groups, and users, see Configuring Users and
Groups on a Local Computer on page 184.

n For information about setting up groups, user names, and passwords, see Configuring Users and
Groups on a Network Domain on page 188.

Installing Image Lab Software
The standard edition of Image Lab Software can be installed on a computer running the Windows or
Mac operating system. The security edition can be installed only on a computer running Windows

Installing Image Lab on a Mac
You can install Image Lab Software from a USB flash drive or from the Bio-Rad website.

To install Image Lab on a Mac from a USB drive

1. Insert the Image Lab software USB flash drive into a USB port on the computer.

2. When the contents appear, double-click the icon.

Two folders appear, Mac and Windows.

3. Open the Mac folder.

4. Double-click the Image Lab.dmg file.

5. Drag the Image Lab application icon into the Applications folder.
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To install Image Lab on a Mac from the website

1. Enter the following URL into a web browser:

https://www.bio-rad.com/ImageLab

2. When the Image Lab page appears, click Log In/Register in the upper-right corner.

3. Do one of the following:

n If you have an account, enter your user name and password, and then clickd
Sign In.

n If you do not have an account, click Register Today and complete the fields under
Registration and Contact Information. When your account is verified, enter your user name
and password, and then click Sign In.

4. Click the Image Lab Software link, and then click Learn More.

5. Select the Download tab, and then click the Software Download button for Image Lab Software for
Mac.

6. Follow the prompts to install the software.
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Installing Image Lab on a Windows PC
Image Lab does not require a license code. However, Image Lab Security Edition does require you to
enter a license code during installation.

Important: Before you install Security Edition, locate the 18-digit license code in the Image Lab
product folder pocket. If you do not have the license code, obtain it from your Bio-Rad customer
service representative before attempting to install the software.

When deciding whether to install Image Lab or Image Lab, Security Edition, consider the following:

n If you are licensed to install the Security Edition but choose to install the Standard Edition, you
must first uninstall the Standard Edition and then install the Security Edition before you can use it.

n If you are licensed to install the Security Edition and choose to install it, note that only a user
assigned the role or group of Image Lab Administrator can enable and disable secure mode.

Note: A user assigned the role of Image Lab Administrator does not have to be the network
or IT administrator.

For more information, see Setting Up Image Lab Security Edition on page 23.

To install Image Lab on a Windows PC

1. Do one of the following:

n To install from a USB flash drive

a. Insert the Image Lab software USB flash drive into a USB port on the computer.

b. When the contents appear, double-click the icon.

Two folders appear, Mac and Windows.

c. Open the Windows folder and double-click ImageLabSetup.exe.

n To install from the website

a. Enter the following URL into a web browser:

https://www.bio-rad.com/ImageLab

b. When the Image Lab page appears, click Log In/Register in the upper-right corner.

Do one of the following:

o If you have an account, enter your user name and password, and then click Sign In.
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o If you do not have an account, click Register Today and complete the fields under
Registration and Contact Information. When your account is verified, enter your user
name and password, and then click Sign In.

c. Click the Image Lab Software link, and then click Learn More.

d. Select the Download tab, and then click the Software Download button for Image Lab
Software for Windows.

The Image Lab installer wizard opens.

2. On the Welcome screen, click Next.

3. Accept the license agreement and click Next.

The Edition Selection dialog appears.
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4. On the Edition Selection screen, do one of the following:

n Install Standard Edition. Skip to Step 7.

n Install Security Edition. Continue to Step 5.

5. (Optional) If you specified the Security Edition, the Validate Code screen appears.

6. Enter your 18–digit license code in the Validate Code screen.

If you are unable to enter a valid license code during installation, you can

n Return to the previous screen and select Standard Mode.

n Enter any 18 characters to serve as a placeholder. The Security Edition will be installed, but
its features remain disabled until you activate them with a valid code. For information, see
Activating Image Lab Security Edition after Installation on page 23.

7. Click Next.

The Destination Folder screen appears.
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8. Accept the default location or click Change and browse to the folder you want.

9. Click Next.

The Ready to Install the Program screen appears.

10. Click Install.

The wizard installs Image Lab.

11. When the installation finishes, a final wizard screen appears, in which you can choose to display
the Release Notes, the Windows Installer log, or both.
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12. Click Finish to exit the wizard.

The Image Lab icon appears on your desktop.

Windows 7 Drivers
On Windows 7, the device driver is installed during Image Lab installation. After installation, a
message confirms that the device driver software installed successfully.

Note: You can ignore the error message below if it appears during installation. The error is more
likely to occur if the instrument is plugged in, but the driver is installed despite the message.
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Setting Up Image Lab Security Edition
When you install the Security Edition, a Security menu is included on the menu bar. From the Security
menu, Image Lab Administrators can do the following:

n Activate Security Edition, if it was not activated during installation

n Enable or disable Secure Mode in Security Preferences

n Rename security groups

n Enable write once support

n Deactivate Security Edition

Activating Image Lab Security Edition after Installation
If you have an unactivated or deactivated version of Security Edition installed, an Activation dialog box
appears each time you open the software.

If you click Cancel, a message appears, advising that Security Edition is not activated.

You can continue to use Security Edition in Standard Mode, but you are prompted to activate the
software each time you open it until Security Edition is activated with a valid license code.

Note: If you need a new license code, contact Bio-Rad Technical Support for assistance.

To activate Security Edition

1. From the Security menu, select Activate Security Edition.
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2. Enter a valid license code in the License Code field.

3. Click Activate.

A message appears, indicating that Security Edition is activated.

4. Click OK.

Security features are now available in the software.

Enabling and Disabling Image Lab Secure Mode
You must have Image Lab Administrator role privileges to switch between Image Lab secure and
standard modes.

To enable secure mode

1. On the Security menu, click Security Preferences to display the Security Preferences dialog box.

2. Select Enable secure mode.

3. Click OK to display the Enable Secure Mode dialog box.
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4. Enter your Image Lab Administrator user name and password.

5. (Optional) If you are working on a Windows network server, type the name of the Windows
domain in the Domain box.

Note: By default the name of the domain on which the current Windows user is located
appears in the Domain box.

6. Click OK to save your changes.

A message instructs you to restart Image Lab.

7. Click OK.

Important: For more information on setting security preferences, see Setting Security Preferences
on page 27.

To disable secure mode

1. On the Security menu, click Security Preferences to display the Security Preferences dialog box.

2. Clear the Enable secure mode checkbox.

3. Click OK.

The Admin Authentication dialog box appears.
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4. Enter your Image Lab Administrator user name and password.

5. If you are working on a Windows network server, type the name of the Windows domain in the
Domain box.

Note: By default the name of the domain on which the current Windows user is located
appears in the box.

6. Click OK to save your changes.

A message instructs you to restart Image Lab.

7. Click OK.
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Setting Security Preferences
You must know your network domain name in order to set security preferences. If you do not know this
name, see Finding Your Authentication Domain Name on page 183 and follow the instructions to
obtain your network domain name.

To set security preferences, you specify the security settings described below.

Setting Description

Network
domain

A remote domain-controlling computer or system, which ensures that
only authorized users with valid credentials can access and run
Image Lab.

Note: By default, the Security Preferences dialog box displays
the name of the domain on which the current user logged in.

Local
domain

Local computer on which Image Lab is running, which ensures that
only authorized users with valid user credentials can access and run
Image Lab.

Credentials Valid user name and password that allows or prohibits specific user
actions

To enable only network domain users to run Image Lab

u In the Domain to be used in authentication box, enter the name of your network domain.

Leave the Use local groups for establishing user security levels checkbox unselected.
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To enable only domain users who are also valid members of specific local groups to run
Image Lab

1. In the Domain to be used in authentication box, enter the name of your network domain.

2. Select the Use local groups for establishing user security levels checkbox.

To enable only local users to run Image Lab

u In the Domain used in authentication box, enter the local computer name.

The Use local groups for establishing user security levels option becomes inactive.
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Renaming Security Groups
To rename any of the default Security Groups

1. From the main menu, select Security > Rename Security Groups.

This menu option is visible only if the person logged into the local computer is logged in as a
member of the Windows Administrators group.

2. Click in any of the Group Name fields.

3. Enter a new name.

4. Click OK to save your changes.

Note: The new user group name must comply with standard Windows Local Users and Groups
user names rules.

For more information on setting up security groups, see Setting Up Users and Groups on page 181.
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Using Groups on a Local Domain
If you choose not to create or use groups on the network domain, set up local groups. Add the
authorized users to the groups on the local domain. In the Security Preferences dialog box, select Use
local groups for establishing user security levels.

For information about setting up users and groups for Image Lab Security Edition, see User Names,
Groups, and Roles on page 172.

Changing Security Preferences
Changing the domain that is used to authenticate users is a two-step process. You first authenticate
on the first domain, then authenticate on the second domain. This change in domains can be
performed in either of two ways. It can be performed by one individual assigned the Image Lab
Administrator role on both domains, or it can be performed by two individuals, one with the
administrator role on the first domain, and the other with the administrator role on the second domain.
See User Authentication and Group Membership on page 182 for more information about using this
dialog box.

Deactivating Image Lab Security Edition
You must have a license for each instance of Image Lab that you install. You can load Image Lab on a
second computer only if you deactivate it on the initial computer first.

You can deactivate Security Edition using the option in the Security menu.

To deactivate Security Edition

1. From the Menu bar, select Security, and then click Deactivate Security Edition.

The Deactivate Security Edition dialog box appears.

2. Click Deactivate.

Security Edition is immediately deactivated, and a success message appears.
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3. Click OK.

Note: To reactivate Security Edition, you must reenter your license code.
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Chapter 3 Image Lab Software Overview
Image Lab Software controls image acquisition and analysis, and saves your settings in protocols you
can reuse for repeatable results.

Main Window
When Image Lab starts, the main window appears.

Main window menu commands enable you to review and arrange multiple screens in the workspace
to facilitate comparison of imaging results.

Names of open protocols and image files appear in the Window menu.

u Click a protocol or image file name to make it active.
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Start Page
By default, the Start Page dialog box appears when Image Lab Starts. You can

n Select the type of protocol to create

n Open a protocol or image file

n View lists of recently saved protocols and image files

n Open external 8-bit and 16-bit, grayscale images stored in .tif format

To start Image Lab without displaying the Start Page

u Clear the checkbox in the bottom left corner of the dialog box.
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Main Toolbar
You can access most Image Lab tools by clicking buttons in the main toolbar.

The main toolbar includes buttons that access different views of results data.

Clicking Screenshot sends a screen capture of the current image to the clipboard or saves it as a file.
Unlimited Undo and Redo actions make it easy to correct missteps.

Results Data
You can view image analysis results data as an analysis table, a lane profile, a standard curve, or a
report, and you can display all views at the same time.

Buttons in this section of the main toolbar access the different views of results data.

For information about each view, see Chapter 5, Viewing Images and Image Data.

Display Toolbox
The Display Toolbox, located below the main toolbar and above every image provides a variety of
options to display your images.

See Chapter 5, Viewing Images and Image Data for a description of each option.
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Analysis Tool Box
Analysis tools enable you to analyze and image, and are active when an image is selected. For
detailed information about using these tools, see Chapter 6, Analyzing Images.

1. Click Auto-Analysis to analyze an image quickly.

2. Click a button to select the tool you want to use.

Image Tools— flip, rotate, and crop images and transform image files.

Lane and Bands— detect, resize, adjust, and bend lanes; detect, adjust, add, or delete
bands. Normalize volume data in multichannel images to correct for sample loading
errors.

MWAnalysis Tools (Molecular Weight Analysis) — choose standard samples, assign
standard lanes, and choose a regression method.

Quantity Tools— automatically quantify bands using relative or absolute values.

Annotation Tools— add formatted text and arrows to an area of a gel.

Volume Tools—manually quantify an object inside a boundary that you define, and
choose background subtraction method.
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Status Bar
The status bar at the bottom of the main window displays the imager type and the X and Y values at
the cursor position on the image. The status bar also displays the intensity (Int) or optical density (OD)
values for the image at the cursor position. The maximum data range is 0–65,535 (int) or 0.0–4.0 (OD).
However, the actual range varies depending on the values contained within each image.

Tip: (Multichannel images only) Move the pointer over the composite image to display color-
coded intensities for all channels.
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Main Window Menu Commands
This section describes all menu commands in the File, Edit, View, Window, and Help menus. Many
commands are also available on the toolbar or the Start Page.

File Menu Commands

u From the menu bar, select File to display the options described in Table 1.

Command Description

New protocol Create a new protocol, which is a file that stores your settings for acquiring images,
analyzing them, and creating customized reports.

Note: This applies only to imaging systems that are controlled by Image Lab
Software.

Open Browse the file system to retrieve a protocol or image file.

Note: You can open most external 16- or 8-bit TIFF images that are stored in
strip or tile format and are either uncompressed or compressed with LZW. Most
grayscale TIFF images are stored this way.

Recent images Open a recent image file.

Recent protocols Open a recent protocol.

Note: This applies only to imaging systems that are controlled by Image Lab
software.

Save Save a named protocol or image file.

Save as Name and store a protocol or image.

Note: Protocols are stored with a .ptl or .sptl extension. Image files are stored
with an .scn or .sscn extension.

Close Close the active window.

Close all Close all windows.

Table 1. File options
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Command Description

Export Export gel images or analysis tables using the following options:

n Export for publication — export a displayed image to a file. You can select from
.bmp, .png, .jpg, and .tif formats. The gel displays with any lanes, bands, and
annotations that appear on the screen.

n Export for analysis — create a TIF file that retains all gel image data. Analysis data
are not included. Use this option to analyze the image in other software. See
Exporting Gel Images for Publication on page 156

n Export for PulseNet— reduce the image to an 8-bit .tif file. Resolution is limited and
file size is restricted to 300 dots per inch (dpi).

n Lane and band table to Excel — export the lane and band table data to an Excel (or
Numbers on a Mac) spreadsheet (Excel or Numbers must be installed on your
computer).

n Lane and Band table to file — export as a comma-separated values (CSV) file so
that the lane and band table can be opened in a database application.

n Volume table to Excel — export volume table data to an Excel (or Numbers on a
Mac) spreadsheet (Excel or Numbers must be installed on your computer).

n Volume table to file — export as a CSV file so the volume table can be opened in a
database application.

Note: See Exporting Results on page 155 for more information about exporting
files.

Image info Display information about individual gel and blot images, such as acquisition date and
data range, and image capture detail, such as exposure time and illumination source
used.

Note: Click the Image Details, Analysis Settings, and Notes tabs to display
these properties. See Image Info on page 76 for more information.

Page setup Access print settings such as orientation (landscape or portrait), margins, printer
used, and paper size.

Print Display a preview of the gel and header information, which includes the file name of
the image, the user’s name, and the date and time of printing.

Note: Click Print in the Print Preview dialog box to select a printer and the
number of copies to print.

Exit Close Image Lab.

Table 1. File options, continued
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Edit Menu Commands

u From the menu bar, select Edit to display the options described in Table 2.

Command Description

Undo Undo the last action.

Redo Restore the last action after an Undo.

Screenshot Capture an image of the Lane Profile Window, the Standard Curve Window, or Current
Image View.

You can include the image name in the screenshot, and you can send the screenshot to
the clipboard or save it in a file.

Default imager Connect two or more Bio-Rad imaging systems to the same computer, allowing users
to switch between them..

Instrument setup Display information about the instrument, including its name, serial number, camera
serial number, illumination options, and last calibration.

If you add accessories to the instrument, you can reset the system calibration in this
dialog box.

Report settings Select or clear checkboxes to configure reports from different tabs. Selections apply to
all reports.

n The General tab has options for excluding or reporting information about your gel
image.

n The Lane and Band Table tab enables the researcher to choose whether to include
all lanes or selected lanes, with appropriate identifiers. Lane profiles can also be
included.

n The Volume Table tab enables the researcher to choose appropriate identifiers for
the volume table and provides the option of excluding the table from reports.

n The Lane Statistics tab enables the researcher to change the statistical categories
that are displayed in reports.

Table 2. Edit options
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Command Description

Preferences Set naming and color preferences for image files.

n The Protocol tab display presets for naming image files. You can include a
designated Prefix, User Name, Date, and Time in the name of your image files.

n The Colors tab allows you to choose colors for the graphic elements in gels, such as
Lane Frame, Lane, Band, Band Attribute, and MW Legend to ensure that the
elements are visible, regardless of the gel color.

Note: This dialog box has two tabs and can also be accessed from the Image Lab
menu in a Mac OS.

Table 2. Edit options, continued
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View Menu Commands

u From the menu bar, select View to display the options described in Table 3.

Command Description

Image overview Display the gel image with a red rectangle outlining the area visible in the larger
main window. This is useful when you zoom in to a small section of an image.

Image transform Display a histogram that enables you to adjust the light and dark values of a gel
image. This adjustment does not change your data, only the way the data display on
your monitor.

Operations history Display the sequence of actions performed by both the user and the software.

View system log Display a log of events related to running Image Lab software, including enabling or
disabling secure mode, and the users who log on to or log off of the software.

View instrument log Display events related to the instrument, including calibrating the instrument and
the success or failure of the calibration. This log file is visible only if Image Lab is
used to control an instrument.

View document log When Security Edition is enabled, display events related to creating and modifying
secure protocol and image files.

Table 3. View options
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Security Menu Commands

u From the menu bar, select Security to display the options described in Table 4.

Important: This menu is visible only in Image Lab Security Edition. For more information, see
Chapter 10, Using the Security Edition.

Command Description

Security
preferences

Allows the Image Lab Administrator to enable and disable secure mode, choose
the domain to be used for authentication, and choose whether to use local groups
for security levels.

Rename security
groups

Allows a user logged in as a member the Windows Administrators group to change
any of the four default Image Lab security group names (TDS_Administrator, TDS_
User, TDS_Tech, and TDS_Guest).

Note: This command is visible only if the user logged into the local computer
as a member of the Windows Administrators group. Only users logged in as a
member of that group maintain the authority to change any of the four default
Image Lab security group names. Any changes made to these Security Group
names must match the names your Windows system administrator has given
those groups.

Sign document Enables users to sign images and protocols. Users enter their user name and
password and provide a reason for signing. When the document is signed, the
reason is saved in the System Log file.

Table 4. Security options
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Window Menu Commands

Window menu commands enable you to show and hide multiple open image files in the workspace.
This menu also lists all currently open images and protocols.

u From the menu bar, select Window to display the options described in Table 5.

Command Description

Tile Align all open image files so they are visible at the same time.

Tile horizontal Align all open image files from top to bottom.

Tile vertical Align all open image files from left to right.

Cascade Stack all open image files and protocols with overlapping title bars, so each one
can be easily chosen for viewing.

Imitate zoom Change the zoom setting of all open images to the zoom setting of the current
image file.

Imitate transform Change the brightness and contrast of all open images to the transform settings of
the current image file.

Next Cycle through all open image files from oldest to newest.

Previous Cycle through all open image files from newest to oldest.

Table 5. Windows options
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Help Menu Commands

u From the menu bar, select Help to display the options described in Table 6.

Command Description

Image Lab User
Guide

Display this guide.

Instrument Guides Display a list of instument guides for imaging systems that work with Image Lab
Software.

Register Image Lab Display the Image Lab Registration Form.

About Display Image Lab software version, release date, and copyright information.

Table 6. Help options
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Image Lab Software runs configurable, application-based protocols for sample imaging.

A protocol includes the settings for acquiring images, analyzing them, and creating customized
reports. You can retrieve, revise, and reuse protocols.

Image Lab supports single channel and multichannel protocols.

You can use Image Lab to analyze images acquired by any Bio-Rad imaging system.

Important: This chapter describes the major steps of creating and running protocols. Because
protocol settings are specific to each imaging system, more detailed procedures about image
acquisition settings and running protocols appear in the instrument guide for your imaging
system.

View Screens Designed for Your Imager
When you turn on an imager connected to the computer running Image Lab software, Image Lab
detects the imager type and displays screens relevant to its use. To see if your computer is connected
to your imager, check the imager status. The name of the selected imager appears on the status bar in
the right corner of the Image Lab screen:

The green check mark next to the instrument name indicates that the instrument is connected to the
computer running Image Lab software and is communicating with Image Lab.

Tip: To create protocols for another imager, choose a different imager name in the dropdown list.

User Guide | 47



Chapter 4 Protocols

The Protocol Setup Window
Note: The images in this section show a protocol for the GS-900 Calibrated Densitometer. If you
are using a different imager, the screen might look slightly different.

In the left pane, numbered Protocol Setup steps appear under different headings.

1. Select or clear checkboxes to enable or disable steps. When you select a step, the right pane
displays detailed settings for that step.

2. Click Protocol Summary in the left pane to review protocol settings. In the right pane, the summary
lists the settings for each step.
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Protocol Setup Steps
You configure the following settings to create a protocol:

n Acquisition Settings — (required) acquire the image

n Analyze Image — (optional) detect lanes and bands and analyze the molecular weight

n Generate Output — (optional) print the image; print or display the report

Image Lab Software presents these steps in a series of Protocol Setup screens. The left pane in each
screen lists the tasks of each major protocol step. Protocol Setup screens appear in the order listed in
the left pane. After you configure each Protocol Setup step, you can view a summary of your settings
and you can return to a previous step and edit its settings.

Note: Example screens in this chapter might look slightly different from protocol setup screens on
your imaging system.

Acquisition Settings

Acquisition settings include

n Selecting an application with predefined image acquisition settings optimal for the sample type

n Specifying settings for the imaging area

n Setting the image exposure time and choosing to optimize for faint or intense bands

n Setting display options to highly saturate pixels and choose a color for the image
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Custom Applications

Applications you can select for acquiring images are predefined with image acquisition settings
optimal for your sample type. The applications list is specific to your imaging system.

The Application menu also includes a Custom command that enables you to create a custom
application. You can also create a custom application identical to a predefined application and
rename it. Saved custom applications can be reused or edited.

Note: A detailed procedure specific to your imaging system for creating a custom application
appears in the chapter Acquiring Images in your imaging system instrument guide.
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Multichannel Acquisition Settings

An imager that can acquire images with a multichannel protocol displays acquisition settings for each
channel you use. As you configure channels, the software displays available acquisition settings for
each channel based on settings already selected for other channels.

Analyze Image
In the Analyze Image protocol setup, you select two steps, Lane and Bands Detection and Analyze
Molecular Weight.

Detecting Lanes and Bands

To analyze the gel or blot, Image Lab must detect lanes and bands on the image. Image Lab
automatically detects lanes and subtracts the background.

Set detection settings so Image Lab can detect lanes and bands to your requirements:

n Specify sensitivity options for band detection

n Select normalization options for multichannel protocols
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Analyzing Molecular Weight
Image Lab calculates the molecular weight for each band based on the standard you specify.

Note: Lane detection works best when standards are placed in the first and last lanes.

Image Lab uses a regression method to calculate the molecular weight of unknown bands.

For information on ordering standards, see Appendix D, Accessories.
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Generate Output

Select the type of output you want for a single image or report:

n Automatically print the image

n Automatically print a report

n Display the report

When you choose Display Report, a scrollable report screen opens (similar to the next image). You
can scroll down to view acquisition settings and analysis data.

You can select options in the report screen toolbar to customize or print the report, create a PDF file, or
adjust the printer settings. For more information, see Report Options
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Detect Lanes and Bands

To analyze the gel or blot, Image Lab must detect lanes and bands on the image. You can set band
detection to a higher sensitivity level so that the software can detect faint bands on the image. Besides
lane and band detection, Image Lab subtracts background automatically. If the sensitivity is set too
high, background staining might be detected as bands. If the setting is too low, bands of interest might
not be detected. For information about adjusting settings manually after acquiring an image, see Lane
and Bands Settings on page 109.

Note: (Multichannel images only) You cannot specify different sensitivity levels for individual
channels in a multichannel image. The same sensitivity level applies to all channels. After the
image is generated, you can change the sensitivity level for individual channels using Lane and
Bands tools.
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To configure lane and band detection settings

1. Select the Lane and Band Detection checkbox in the left pane of the Protocol Setup window.

2. In the right pane, select a lane and band detection option.

n Low Band Detection Sensitivity— sets detection at a low level (25) for images with more
prominent bands. Faint bands are not detected with this setting.

n High Band Detection Sensitivity— sets detection at a higher level (75) for images that are
fainter. To remove extraneous bands later using Band tab settings in the Lane and Bands.
See Lane and Bands Settings on page 109.

n Custom— sets a numeric value for Sensitivity from 1 to 100 that you choose by using the
slider.

n Advanced— accesses advanced settings. Set more precise values for Sensitivity. Set Size
Scale, Noise Filter, and Shoulder values. Turn on Band Limit and Normalize Sensitivity.
Advanced settings are defined in the section, Advanced Sensitivity Options, under Detecting
Bands on page 118.

Configure the Normalization Channel

(Multichannel images only) You can select and configure any lane in a multichannel image as a
normalization channel.

For more information, see Normalizing Volume Data on page 122.
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Analyze Molecular Weight
Determining molecular weight depends on selecting the proper protein standards. Image Lab
calculates the molecular weight for each band based on the specified protein standard.

Protein and DNA standards are available from Bio-Rad. For more information, see Appendix D,
Accessories.

To analyze the sample molecular weight

1. Select the Analyze Molecular Weight checkbox in the left pane of the Protocol Setup window.

2. Click Change to view a list of predefined standards.

The Manage Standards dialog box appears.
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3. Select the standard and click OK.

If the standard you are using is not on the list, do one of the following:

n Use the Show dropdown list, select All Standards, select the standard you are using, and
click OK.

n Add a standard, select it, and click OK. See To add a standard to the list of predefined
standards on page 58.

n Copy a standard for modification. See To copy a standard and add it to the predefined list of
standards on page 58.

4. Choose the lane(s) that contain your standards by typing lane numbers or the words First and
Last in the Standard Lanes box. The format is xx, xx, xx, and so on, where xx is the lane number.
For example, if you run an 18-well gel and want your standards in lanes 1, 10, and 18, enter First,
10, Last.

Note: Lane detection works best when standards are placed in the first and last lanes. For
nucleic acid samples, use this step to determine the size of the bands in base pairs.

For information about manually estimating molecular weight after image acquisition, see
Molecular Weight (MW) Analysis Tools on page 131.
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5. Select the appropriate regression method:

n Point to Point (semi-log)

n Linear (semi-log)

n Logistic

n Cubic Spine

For more information, see Regression Methods on page 147.

To copy a standard and add it to the predefined list of standards

1. Click Change in the Analyze Molecular Weight protocol setup screen.

The Manage Standards dialog box appears.

2. Select a standard that closely matches the standard you are using.

3. Click Copy.

The copy is added to the list.

4. Select the copy of the standard you chose.

5. Click Edit.

The Edit Standard dialog box appears.

6. Change the name, type, units, and values to match the standard you are using.

7. When you are finished, click OK.

To add a standard to the list of predefined standards

1. Click Change to display the Manage Standards dialog box.

2. Click New.

The Edit Standard dialog box appears.
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3. Type the name of the standard you are using.

4. In the Type dropdown list, select Protein Standard or Nucleic Acid Standard.

5. In the Units dropdown list, select the unit of measure for the molecular weight size markers.

6. Click Add.

The Edit dialog box appears.

7. Type a value for each molecular weight size markers and click OK. Adding a description is
optional.

Note: You must enter at least two molecular weight size marker values.
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8. When you are finished entering values, click OK.

Specify Output
To specify protocol output

1. Select Specify Output in the left pane of the Protocol Setup window to display output options.

2. In the right pane, choose an output option:

n Automatically print the image

n Automatically print a report

n Display the report

Image Lab prints to the default printer unless you specify otherwise. For information about
customizing reporting options, see Report Options on page 149.
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Setting Up a Custom Application
When you create a custom application you can combine acquisition settings based on the following
variables.

Note: The list of variables varies depending on the imaging system.

n Light source

n Filter

n Tray

n Image or display color

n Binning

n Scan mode

To learn more about creating a custom application, see the chapter Acquiring Images in the
instrument guide for your imaging system.
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Review Protocol Settings
Click Protocol Summary in the left pane of the Protocol Setup window to display a summary of all
protocol settings:

Editing a Saved Protocol
You can open a protocol, change settings, disable a protocol step, and save the protocol.
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Running a Protocol
Detailed procedures for running a protocol appear in the chapter Acquiring Images in the instrument
guide for your specific imaging system.

Note: (GelDoc EZ only) Running a protocol in this imaging system requires different steps. See
the detailed procedure in your instrument guide.

To run a protocol

1. Position the gel in the imager.

2. On the Protocol Setup screen, click Run Protocol.

Image Lab runs the protocol in imaging mode.

After acquiring the image, Image Lab continues with the steps selected during protocol setup, such as
detection, analysis, and output. The protocol steps appear in boxes across the top of the screen.
Image Lab highlights each step as it is completed.

When the protocol ends, the image appears in the workspace. You can edit and save the image or
analyze it further.

To cancel the protocol in progress

u Click Cancel Run.
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Regression Methods
A regression method is used to calculate the molecular weight of unknown bands. Image Lab uses the
relative front and molecular weight values of the standard bands to calculate the standard curve. The
standard curve is then used to calculate the values of the unknown bands. The shape of the standard
curve is based on the selected regression method.

During Protocol Setup step 3. Analyze Molecular Weight, you must choose one of the following
regression methods.

Regression Method
Minimum number
of standard bands

Linear (semi-log) 2

Point-to-point (semi-log) 2

Logistic 5

Cubic spline 5

 Regression Methods

The molecular weight of each band appears in the Mol. Wt./Base Pair column in the analysis table. If
you do not have enough data points for the method you select, the molecular weight of the unknown
bands is not calculated.

You can check how well each regression method fits the data in the standard curve window. For more
information, see Standard Curve on page 99. The linear (semi-log) regression method provides a
measurement that describes how well the standard curve fits the data R2 value. The closer the R2

value is to 1.0, the better the data fit the standard curve.
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To display the standard curve

1. Click Standard Curve on the toolbar.

2. In the Standard Curve dialog box, select the Volume Standard Curve tab.

Note:When the Force Through Origin checkbox is selected, the standard curve graph starts at
0,0, regardless of the best curve fit.

See Appendix A, Regression Calculation Methods, to learn how each regression method is
calculated.

See Molecular Weight (MW) Analysis Tools on page 131 for more information about molecular weight.
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Chapter 5 Viewing Images and Image Data
After a gel is imaged, the image appears in the Image Lab software workspace.

The following image shows a gel image with band and lane detection and annotations. The labels are
overlays that you can display or hide.

You can view data as an analysis table, a standard curve, and a report.
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Displaying Gel Images
The Display Toolbox appears above the gel image. Each tool is described in the following sections.

1 Display Gel Options 5 Image transform

2 Zoom in 6 Change image colors

3 Zoom out 7 Switch to 3D view

4 Fit in window 8 Image info

LEGEND
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Display Gel Options

To display gel options

u Click the Display Gel Options icon in the Display Toolbox above the image.

The Display Gel Options dialog box appears.

Annotations

Under Annotations, you can choose whether to show text and arrow annotations that have been
drawn on the image.

Lanes and Bands

Under Lanes and Bands, you can turn on or off image overlays, such as lane frames, lanes, bands,
lane labels, molecular weight legends, and band edges.
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Band Attributes

Under Band Attributes, you can select one of the following attributes to display for a selected lane or
for all lanes.

n Band number

n Band label

n Molecular weight

n Relative front

n Volume

n Absolute Quantity

n Relative Quantity

n Band %

n Lane %

Volumes

Under Volumes, when you draw volume boundaries on the gel, you can display the boundaries and
their volume labels.
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Zoom Tools

Zoom tools resize the gel image.

To enlarge the image

u Click the magnifying glass with the plus sign.

To reduce the image size

u Click the magnifying glass with the minus sign.

You can also zoom in and out using the mouse.

To zoom in and out by dragging

1. With the pointer in the image, hold down the Alt key and drag the pointer to surround the area of
interest.

The image area you selected fills the screen.

2. Double-click in the image to return it to full size view.

To zoom in and out by scrolling

1. With the pointer in the image, hold down the Ctrl key (PC) or Command key (Mac) and use the
mouse wheel to scroll up and down to enlarge or shrink the image.

2. Double-click in the image to return it to full size view.
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Fit in Window

After you zoom in on an area of an image, clicking Fit in Window restores the image to full size view.

Fit in Window is also useful when you display a channel image in single view. Click Fit in Window to
display the selected channel image in full size view.

Image Transform
In this dialog box, you can adjust image brightness and contrast to optimize the image display so faint
details can be seen.

Note: Image Transform adjustments do not change the data. They change only the way the data
are displayed.

To access image transform options

u Click the Image Transform icon in the Display Toolbox above the image.

The Image Transform dialog box appears.

The minimum to maximum range varies depending on the light and dark values present in the image.
The human eye cannot see the full range the image contains.

The frequency distribution histogram shows the total data range in the image and the amount of data
at each point in the range.

Auto Scale determines an optimal setting for the image automatically. The lightest part of the image is
set to the minimum intensity. The darkest is set to the maximum.
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Set Intensity Values with Sliders

n The High slider determines the intensity value used as the maximum grayscale point in the gel
image.

n The Low slider determines the intensity value used as the maximum grayscale point in the gel
image.

n The Gamma slider changes the grayscale curve. A value of 1 is linear. A value <1 redistributes a
greater proportion of the grayscale to the first half of the intensity values. A value >1 redistributes
a greater proportion of the grayscale to the second half of the intensity values.

Set Intensity Values by Entering Numbers

You can also type numerical values in the boxes next to the sliders.

u Click anywhere on the sliders to move them incrementally.

Options

n Invert image display— inverts dark bands on a light background to light bands on a dark
background. Light bands on a dark background are inverted to dark bands on a light background.

n Highlight saturated pixels— areas of the image with saturated signal intensity (higher than a
measurable range) appear highlighted in red. In multichannel images, you can highlight in red
individual saturated pixels in a channel. You cannot highlight saturated pixels in a composite
image.

n Log histogram— changes the y-axis on the histogram to display the number of pixels at each
intensity value using a linear or logarithmic scale.

Changing Settings in Multichannel Images

In the Image Transform dialog box, you can change settings for each channel in a multichannel
image. To do so, select a channel at the bottom of the dialog box and change the settings for that
channel. Repeat this process for each channel.

In addition to the adjustments described in Image Transform on page 72, you can change the color of
each channel. Changing the channel color in the Image Transform dialog box also updates the title
bar and the channel buttons on the multichannel image.

User Guide | 73



Chapter 5 Viewing Imagesand Image Data

When you change the color of a selected channel in Image Transform, its color also changes in the
composite image.

Image Colors

You can choose a color map for the image results file. Viewing the image with a different color scheme
can make all of the elements in the image more visible.

Note: In multichannel images, you can change colors in individual channels. You cannot change
colors in the composite image.

Changing the color map for an image does not change the data. It changes only the way the data are
displayed.

To access image color options

u Click the Image Colors icon in the Display Toolbox above the image.

The Image Colors dialog box appears.
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The first eight color choices imitate the colors of stained gels. The remaining choices supply enough
color variation to highlight small differences in the image data. The dialog box lists each available
color.

3-D Projection

The 3-D view transforms the gel image into a solid three-dimensional model spinning in space with x,
y, and z dimensions. Accentuate or diminish the relative heights of data points by moving the slider at
the bottom of the window right or left.

Note: In a multichannel image, you can view each channel separately in 3-D. You cannot display
a composite image in 3-D.

To view the intensity of various bands

1. Click 3-D in the Display Toolbox above the image.

The image appears in 3-D.

2. Drag the model to rotate it into your preferred view.

3. Click the image to bring the window into focus.

To evaluate the intensity of various bands

1. On your keyboard, press C to display an inverted green cone in the 3-D view.
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2. Drag the inverted cone around the image.

The intensity value at the cone's location appears in the right corner of the status bar.

3. Press C again to hide the cone.

To leave 3-D view

u Click 3-D in the Display Toolbox.

Image Info

The Image Info dialog box reports information about the active image.

To access image info

1. Click the Image Info icon in the Display Toolbox above the image.

The Image Info dialog box appears.

2. (Multichannel images only) Select a channel.
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Detailed information about the selected channel appears.

Three tabs display the following kinds of image information:

n Image Details— acquisition and image information.

n Analysis Settings— analysis settings used to image the gel. For example, if Band Detection and
Molecular Weight Analysis were performed, their data appear here.

n Notes— Enter any information you like to describe the image, such as the types of samples used,
and add other information about the results. Under Lane Information, you can specify custom
labels for lanes. In a multichannel image, custom labels apply to lanes in all channels.

Displaying Multichannel Images
The multichannel view displays the composite of all channels in the image file as well as an image of
each channel. The name Multichannel appears in the title bar of the composite. An application name
appears in the title bar of each channel image. A yellow border surrounds the active image.
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Multichannel View Settings
In multichannel view the Display Toolbox includes multichannel settings. These settings enable you to
view the multichannel image in color or grayscale, show or hide channels in the multichannel view or
in the composite image, and change the layout of the display.

Most multichannel view settings offer two or more alternatives (for example, the Change Layout icon).
Click a setting to select its alternative.

Legend

1 Show RGB/Grayscale Composite

2 Show/Hide Channel 1

3 Show/Hide Channel 2

4 Show/Hide Channel 3

5 Change Layout

To display or hide the composite image

u Click RGB to display or hide the composite image in the multichannel display.
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To display a multichannel image in RGB or Grayscale

u In the RGB dropdown list, do one of the following:

n Click Show Grayscale Composite to display the composite image in grayscale.

n Click RGB Composite to display the selected channels in color.

In the Display Toolbox RGB changes to Gray or vice-versa to match the setting you choose.

Note: The setting you select also applies to reports, printouts, and exports for display.

To display or hide a channel in the multichannel display

n In the Display Toolbox, click a numbered channel (C1, C2, C3).

To show or hide a channel in the composite image

n In the RGB dropdown list, click Hide or Show a channel in the composite image.

To change the multichannel layout

u In the change channel layout dropdown list, choose a layout.
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Change Layout
You can view multichannel images in four different views.

To select a display view

1. Click the Change Layout icon in the Display Toolbox above the image.

A list of layout views appears.

.

2. Click the view you want.

Grid View

By default, multichannel images appear in grid view.

80 | Image Lab Software



DisplayingMultichannel Images

Vertical View — Images Side by Side

Horizontal View — Images Stacked
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Single View — Selected Channel

Tip: Click Fit in Window in the Display Toolbox to fill the screen with the image.
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Splitting Multichannel Images
You can split a multichannel image into individual image files. When you split a multichannel image,
Image Lab creates a new file for each channel except the RGB channel. Each new file has the same
name as the multichannel image plus the application name in parentheses. All acquisition settings
and overlays are copied to the new files.

To split a multichannel image into separate files

1. Open a multichannel image.

2. In the File menu, click Split Multichannel Image.

Each channel, except the RGB channel, appears in a separate window. The first channel image
appears in the workspace.
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3. Save the channel image as a new file.

4. To view another channel image, select it in the Windows menu.

5. Save each channel image in a separate file.

Creating a Multichannel Image from Acquired Single Images
You can create an unlinked multichannel image from acquired single images or from single channels
in a multichannel image that are open in Image Lab software. Only images with the same aspect ratio
can be combined in a multichannel image. Because the images are not linked, a change you make to
one image has no affect on the others.

Note: The type of multichannel image described in this section is different from a multichannel
image that is created during acquisition with a multichannel-capable imager. Any imager can
acquire single images that you can put together using the Create a Multichannel Image option in
Image Lab.

To create a multichannel image from single images

1. Open the single images from which you want to create a multichannel image.

2. In the File menu, click Create Multichannel Image. The list of open images appears in the Create
Multichannel Image dialog box.

3. Drag each image into a channel box in the right pane. Once you select the first file, the Available
Open Images list displays only files with the same aspect ratio.
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4. (Optional) Specify a color for each channel in the accompanying dropdown lists. The resulting
multichannel image appears in the Image Preview.

5. Click OK to save the multichannel image.

To replace a channel in a multichannel image

1. Open the multichannel image and the new image you want to use.

2. In the File menu, select Create Multichannel Image. The open image files appear in the
Compatible Open Images list.

3. Drag the images you want to keep from the Available Open Images list (left pane) into the
channels in the New Multichannel Image pane (right pane).

4. Drag the new image you want to use into one of the available channel boxes.

5. Click OK to save the new multichannel image.

Displaying Data
You can view results from analyzed data associated with a gel image in an analysis table, a lane
profile, a standard curve, or a report. Main toolbar buttons turn these views on or off. You can view
data in all views simultaneously.
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Analysis Table

The Analysis Table tool appears in the Results Data section of the main toolbar. The analysis table
displays image data for the selected image in results tables that appear in three tabs.

Lane and Band Table

This table displays lane and band volumes in order by lane number. For a multichannel image, the
table displays data for each channel in its channel color.

Lane and Band Measurement Columns

Channel— the channel that contains the volume.

Lane— the number of the lane that contains the band.

Band No.— The number of the band in the lane.

Band Label— to assign a custom label to each band, click the Band Label box in the row for the band
and type a name.

Molecular Weight— the molecular weight of the band is calculated based on the standard and
regression method you define. Italic values indicate extrapolated values. For nucleic acid gels, the
band size band appears in base pairs.

Relative Front— values between 0–1 indicate the relative movement of the band from top to bottom.

Adj. Volume— The volume with background subtracted.

Volume— the sum of all the intensities in the volume.

Abs. Quant.— absolute quantification of the band.

Rel. Quant.— relative quantification of the band compared to the reference band.
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Band%— percentage of the band’s volume compared to all band volumes in the lane.

Lane %— percentage of the band’s volume compared to the entire volume of the lane.

Norm. Factor —the correction factor for the lane that contains the band.

Norm. Vol. (Int)— the adjusted volume corrected by the normalization factor.

Volume Table

This table displays volume analysis values obtained arbitrarily, that is, in a slightly more manual way
than in automatic analysis. A greater variety of shapes can be selected. Volume analysis also includes
two ways to control background that are different from those applied in lanes and bands analysis.

Volume Measurement Columns

Volume Number— a unique number assigned to each volume.

Volume Label— software-generated labels for different types of volumes
(U – unknown, B – background, S – standard). You can change labels can in Volume Properties.

Volume— the sum of all the intensities within the band boundaries.

Adjusted Volume— the background-adjusted volume.

Mean Background— the mean intensity of the background of the band.

Absolute Quantity Volume— the quantity of the volume based on the standard volumes and the
regression method.

Relative Quantity Volume— the ratio of the band to the reference volume.

# Pixels— number of pixels in the volume.

Minimum Value— the minimum pixel value in the volume.

Maximum Value— the maximum value of the pixels in the volume.

Mean Value—mean value of all pixel values in the volume.

Standard Deviation— standard deviation of all pixel values in the volume.

Area— the area of the volume in square millimeters.
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Lane Statistics Table

This table is associated with the lanes and bands analysis. Molecular weight is based on lanes and
bands found. All lane statistics apply to the whole lane and include the normalization factor associated
with normalized lanes.

Note: You cannot change the orientation of the Lane Statistics table.

Display Data Options

Display Data options appear in the top left corner of the analysis table toolbar.

To display data options

u Click the Display Data Options icon in the analysis table toolbar.

The Display Data dialog box appears.
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The Display Data Options dialog box displays three tabs.

Measurements— choose the measurements to display in the table.

u Click the arrows to move columns between Not Displayed pane and the Displayed panes. By
default, all measurements appear in the analysis table.

Note: For a description of each Lane and Band measurement type, see Lane and Band
Table Measurements on page 91. For a description of each Volume measurement type, see
Volume Measurements on page 92.

Display— specify display settings for the analysis table.

n Default display settings— By default the Move selected lane to top checkbox is selected by
default. When you click a lane on the image, the analysis table scrolls to display the selected lane
first in the vertical or horizontal table view.

n Per Measurement Precision— set the precision (decimal places) for measurements in the Lane
and Band and Volume tables.

n Example— display an example of how measurements look with the selected measurement and
precision settings.

Export— choose how to export analysis data. The following settings appear on the Export tab:

n Export formatting— select checkboxes to include lane headers (Lane and Band table tab only)
or column headers, or both, in the exported file.

n Export delimiter— select a delimiter for the exported file.

o Comma delimited
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o Tab delimited

o Use other delimiter (user defined)

Change Analysis Table Orientation

The Change analysis table orientation icon appears in the analysis table toolbar.

u Click this icon to toggle between horizontal and vertical table orientations.

Note: You cannot change the orientation of the Lane Statistics table, which appears when you
click the Lane Statistics tab in the analysis table.

Horizontal— displays lanes and volume data rows beside each other. You can scroll through the
table from left to right.

Vertical— displays the lanes and volumes data rows vertically. You can scroll through the table from
top to bottom.

Copy Analysis Table to the Clipboard

The Copy analysis table to the clipboard icon appears in the analysis table toolbar.

u Click this icon to copy the analysis table to the clipboard.

You can then paste the analysis table into a word processing or presentation application.

Note: Copying the table in vertical orientation to an 8.5 x 11-inch page best accommodates the
table columns.

Export Analysis Table to a File

The Export analysis table to a file icon appears in the analysis table toolbar.

u Click this icon to export the table data as a CSV file that you can open in a database application.

Export Analysis Table to Excel

The Export analysis table to Excel icon appears in the analysis table toolbar.

u Click this icon to export the table data to a spreadsheet.

You can use the sorting and formula functions to manipulate the data. If Excel (PC or Mac) or Numbers
(Mac) installed is installed on your computer, the software opens and displays the spreadsheet.
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Lane and Band Table Measurements
The following measurements appear in the Lane and Band tab of the Analysis table.

u Click the Display data options button in the analysis table toolbar to choose columns.

Lane— each lane has a unique number.

Channel— (for multichannel images) lists the application used.

Band Number— each band in a lane has a unique number, sorted from top to bottom.

Band Label— you can assign a custom label to each band by clicking the Band Label box in the
Lane and Band table.

Molecular Weight— the molecular weight of the band is calculated based on the standard and
regression method you define. Italic values indicate extrapolated values. For nucleic acid gels, the
size of the band is displayed in base pairs.

Relative Front— values between 0–1 indicate the relative movement of the band from top to bottom.

Volume— the sum of all intensities within the band boundaries.

Adj Volume— lists the adjusted volume of a band after background subtraction.

Abs. Quant.— absolute quantification of the band.

Rel. Quant.— relative quantification of the band compared to the reference band.

Band%— percentage of the band’s volume compared to all band volumes in the lane.

Lane %— percentage of the band’s volume compared to the entire volume of the lane.

Norm. Factor —(multichannel images only) the correction factor for the lane that contains the band.

Norm. Vol. (Int)— (multichannel images only) the adjusted volume corrected by the normalization
factor.
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Volume Measurements
The following measurements appear in the Volume tab of the Analysis table.

u Click the Display data options button in the analysis table toolbar to choose the columns to
display.

Volume Number— a unique number assigned to each volume.

Volume Type—U – unknown, B – background, S – standard

Volume Label— software-generated labels for different types of volumes (you can change the label in
Volume Properties)

Volume— the sum of all the intensities within the band boundaries.

Adjusted Volume— the background-adjusted volume.

Mean Background— the mean value of the background.

Absolute Quantity Volume— the quantity of the volume based on the standard volumes and the
regression method.

Relative Quantity Volume— the ratio of the adjusted volume and the adjusted volume of the
reference volume.

# Pixels— number of pixels inside the volume boundary.

Minimum Value— intensity of the pixel with the minimum intensity inside the volume.

Maximum Value— intensity of the pixel with the maximum intensity inside the volume.

Mean Value—mean value of all pixels inside the volume boundary.

Standard Deviation— standard deviation of all pixels inside the volume boundary.

Area— area of the volume in mm2.
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Lane Profile

The Lane Profile icon appears in the Results Data section of the main toolbar.

u Click Lane Profile to display a cross-section view of a single lane rotated 90°.

A Background Subtraction bar appears in the lower left corner of the Lane Profile window. When you
move the pointer over a lane profile, the current relative front (Rf) value and the average value at the
Rf value appear in the lower right corner of the window.

An image of the selected lane appears below the graph of lane intensities. The transform and color
map are applied to the grayscale image.

The composite channel of a multichannel image always displays a grayscale image of the lane with
the default transform applied to that lane. For single channel images and individual channels of a
multichannel image, the transform and color map are applied to the grayscale image.

The title bar identifies the lane profile in view (Lane 1, Lane 2, and so on). Lane profile titles of
multichannel images include the channel name, for example, Lane 2 (DyLight650).

The following settings appear in the Lane Profile toolbar from left to right:

n Zoom in and out

n Scale to fit graph

n Include Background

n Identify Bands by
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n Detect bands

n Lane (select lane number with Previous and Next arrows)

To view profiles of other lanes

Do one of the following:

n In the toolbar, click the Previous and Next arrows next to Lane to view profiles of other lanes in the
image.

n In the window, click a lane to display its profile.

To view the lane profile of each channel in a multichannel image

1. Click a channel.

By default, the Lane Profile window displays the lane profile for Lane 1 in the selected channel.

2. Click the Previous and Next arrows to view the profiles of other lanes in the channel.

3. Repeat steps 1–2 to view lane profiles in other channels.
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Scale to Fit Graph

1. Select this checkbox to define the range of the lane profile graph by its highest vertical point.

This setting fits the entire graph into the window.

2. Clear the Scale to Fit Graph checkbox to display the entire range of possible intensity values in
the graph.

Doing so allows valid comparisons between different lanes.

Include Background

The area used for band quantification appears in green between the red and blue lines in the lane
profile graph.

1. Select the Include Background checkbox to display the subtracted background in gray, just below
the blue line.

2. Clear the checkbox to remove the background.
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Identify Bands by

By default, bands are labeled by band number.

To change how bands are labeled in the lane profile, select a label type from the dropdown list:

n Band Number (Band No.)

n Band Label

n Molecular Weight (Mol. Wt.)

n Relative Front

n Volume

n Adjusted Volume (Adj. Volume)

n Absolute Quantity (Abs. Quant.)

n Relative Quantity (Rel. Quant.)

n Band %

n Lane %

n Normalization Factor (multichannel images only)

n Normalization Volume (multichannel images only)
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Adjusting Band Boundaries

The lane profile graph displays bands in a lane as green areas. Below the lane profile graph, a lane
image strip displays each band delimited by a pair of vertical lines.

You can move the vertical lines or the green graphic areas to change band boundaries.

Note: Boundary lines cannot overlap. You cannot move a boundary line beyond the next
boundary line.

To adjust band boundaries

1. Point to a boundary line in the graph or strip.

The cursor changes to a double-arrow and a statistics box appears briefly.

2. Drag the boundary to a new position.
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Adding and Deleting Bands — Lane Profile
You can add and delete bands in the Lane Profile window if you have the right to modify the image.

When you attempt to modify an image, the cursor changes to a plus sign. If you are unable to modify
the image, the cursor does not change and you cannot add or delete bands from the image.

Note: You can also edit bands in the Bands window. For information, seeEditing Bands on page
121.

To add a band in the graph

1. Position the pointer where you want to add the band.

2. Press Ctrl-click (PC) or Command-click (Mac).

The cursor changes to a plus sign.

3. Image Lab adds the band and renumbers the bands in the lane profile.

To delete a band in graph

1. Position the pointer on the band you want to delete.

2. Hold down the Ctrl key (PC) or Command key (Mac).

The cursor changes to an X.

3. Hold down the Ctrl/Command key and click inside the band.

Image Lab deletes the band and renumbers the bands in the lane profile.
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Standard Curve

The Standard Curve dialog box displays the best curve fit for the defined standards and the bands
relative to this curve for the lane selected in the image. The tabs at the bottom of the dialog box display
the standard curves for three different analyses.

Standards appear in green. Unknown bands appear in red. You can toggle the molecular weight
display on the y-axis between linear and log scale by clicking the Log y-axis box at the upper left. The
regression method you chose in Molecular Weight Analysis Tools appears, as well as the formula (if
applicable) and the R2 value of the regression method.

Tabs in this window enable you to view the molecular weight standard curve, the absolute quantity
standard curve, or the volume standard curve.

Report

See See Generating Reports for information about reports.
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Chapter 6 Analyzing Images
Analysis Tool Box tools are active when an image file is open and in focus.

n In the Windows environment, an active or in-focus Image Lab window displays a slightly darker
title bar.

n On a Mac computer, active window control icons appear brighter than others.

Image Types
Image Lab creates the following image types:

n Single-channel images

n Linked multichannel images

n Unlinked multichannel images

Linked Multichannel Images

The multichannel view of a multichannel image is a composite of single channels collected by a
multichannel protocol. A multichannel image can consist of up to three images. A linked multichannel
image is acquired using the multichannel protocol. When you detect lanes in one channel of the
image, Image Lab automatically detects lanes in the other channels.

Unlinked Multichannel Images

Unlinked multichannel images are generated by combining several images using the Create
Multichannel Image feature. Detecting lanes in one channel has no effect on the other channels. You
must apply lane detection to each channel separately.

Auto Analysis
Auto analysis detects lanes and bands. It can also calculate the molecular weight of the bands in an
image. Auto Analysis does not find bands in the normalization channel because these bands are not
usually of interest.

u Click Auto-Analysis in the Analysis Tool Box to do the following:

n Analyze images obtained with protocols without steps for auto detection and analysis.

n Change analysis parameters to reanalyze images.
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Note:When you change settings for an analyzed gel, Image Lab overwrites the initial analysis. To
preserve both analyses, save each image file with a different name. To recover an overwritten
analysis, click Undo in the main toolbar.

(Multichannel images only) Band Detection Sensitivity and Molecular Weight Analysis settings apply
to all channels in a multichannel image. You can select different sensitivity levels to detect bands in
each channel using Lane and Bands settings.

In unlinked multichannel images with no normalization channel, lane and band detection are
performed independently for each channel. For unlinked multichannel images with a normalization
channel, lane finding is performed in the normalization channel and copied to the other channels.
Band finding is performed only in the sample channels.

Auto Detection Settings

Low Band Detection Sensitivity— sets detection at a low level for images with prominent bands.
Faint bands are not detected with this setting.

High Band Detection Sensitivity— sets detection at a higher level for images that are faint.
Extraneous bands can be removed using the Band Tools in the Analysis Tool Box. See Lane and
Bands Settings on page 109

Custom— enables you to set a value between 1 and 100 to select the best detection sensitivity for
your sample. You can also drag the sliding bar left or right to set the value.

When Low Band Detection Sensitivity is selected, the numerical value is set at 25; when High Band
Detection Sensitivity is selected, the value is set at 75.
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Molecular Weight Analysis Settings
Molecular Weight Standard— choose any of the many Bio-Rad standards or a standard you added
to the standards list.

Standard Lanes— choose or change the lanes in which the standards are placed.

Regression Method— four regression methods are available. For more information, see Regression
Calculation Methods on page 179

Analysis Tool Box Tools
Analysis Tool Box tools customize the analyzed data in image files. These tools are available only
when an image file is open in the workspace.

Note: Some tools delete the existing analysis. Screen messages notify you before you complete
actions that delete the analysis.

To access a tool

u Click a toolbox button.

To return to the Analysis Tool Box

u Click the Back arrow to the left of the tool name.

To hide the toolbox pane

u Click the double arrow to the right of the tool name.

See Analysis Tool Box on page 36for more information about these tools.
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Image Tools
Image tools enable you to manipulate images.

To display the image tools menu

u Click Image Tools in the Analysis Tool Box.

Flip— flip the gel image horizontally or vertically.

Rotate— rotate the gel image 90° using the Left or Right buttons. You
can also set a custom rotation using the Custom button.

Crop— trim the outer edges of your image to any shape or area.

Invert Data— toggle the image data from positive to negative.

Merge—merge any two single channel images of the same size, for
example, a chemiluminescent blot image, with a colorimetric image of the
same blot
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Correcting a Slanted Gel
To correct a slanted gel

1. In the Rotate section under Image Tools, click Custom.

Red arrows appear on the gel image.

2. Drag the red arrows to rotate them any degree between 0 and 360.

3. Right-click the gel image and click Rotate to set the gel in the new position.
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Cropping a Gel Image
You can save crop settings and use them to crop other images. Saved crop settings are useful when
you want to crop the same area in several images.

To crop a gel image

1. Click Crop under Image Tools in the Analysis Tool Box.

A red box outlines the image area.

2. Drag the red box to surround the image area you want to keep.

3. (Optional) Right-click the image to open the Crop menu and click Save Crop Settings.

The Save Crop Settings dialog box appears.

4. (Optional) Type a name for the crop settings and click OK.

5. Right-click and select Crop.

6. Image Lab crops the image to the area inside the red box.

To crop an image using saved crop settings

1. Click Crop.

A red box outlines the image area.

2. Right-click the image to open the Crop menu and click Load Crop Settings.

3. Select the saved crop settings you want to use and click Load.

The red box resizes and the crop specifications appear on the image.

4. Right-click and select Crop.

Image Lab crops the image to the area specified in the crop settings.

To delete crop settings

1. With an image open, click Crop.

2. Right-click the image inside the red box to open the Crop menu.

3. Click Delete Crop Settings.

4. Select the crop settings in the dialog box that appears and click Delete.
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Inverting Data
Invert Data is used for negative stains and zymograms. In order to analyze the gel, the intensity values
of its bands must be greater than its background.

To determine if image data must be inverted

u View the gel as a 3-D projection.

To invert data

u With the image open, click Invert Data under Image Tools in the Analysis Tool Box.

The image data changes from positive to negative.

Merging Images
You can merge any two single channel images of the same size. For example, you can merge a
chemiluminescent blot image with a colorimetric image of the same blot. Using colorimetric prestained
standards for a chemiluminescent blot, you can acquire an
epi-white light image of the blot to show the standards and a chemiluminescent image to show
immunodetection. Data from the two images can then be combined into a third single image with both
signals.

Note: Merging images can adversely affect quantification. If accurate quantification is required,
perform analysis on the original, separate images.

To merge two same-size images

u With both images open in the workspace, click Merge under Image Tools in the Analysis Tool
Box.
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Lane and Bands Settings
Lane and Bands settings enable you to identify the lanes and bands in an image.

To access Lane and Bands settings

u With an image open in the workspace, click Lane and Bands in the left pane.

Lane and Bands detection settings appear in the right pane.

Normalization settings also appear on the Lanes tab.
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Detecting Lanes
To detect lanes in an image

u Do one of the following:

n If the imaged gel is a standard size, click Automatic.

n If automatic lane detection does not find all lanes, click Manual.

n To detect a specific number of lanes, click Manual and enter the number of lanes you want to
find.

Detecting Lanes in a Multichannel Image
Automatic lane detection works differently in multichannel images depending on whether the
channels are linked or unlinked. In a linked multichannel image, lane detection is based on the
selected channel, and lanes are detected in all channels. In an unlinked multichannel image, lane
detection is based only on the selected channel. You must select and apply automatic lane detection
to each lane separately. The lanes in an unlinked multichannel image can fall in slightly different
places on each channel.

To detect lanes automatically in a multichannel image

u Select a channel and click Automatic in the Lanes tab.

To correct the position of detected lanes in an unlinked multichannel image

1. In the Lanes tab, click Automatic or Manual to detect the lanes in one channel.

2. Do one of the following:

n Repeat step 1 for each channel separately.

n Copy the detected lanes into the other channels and align the lanes in each channel. See
Copying Lanes on page 117 for more information.
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Editing Lanes
After lanes are detected they appear on the image numbered from left to right. By default the first lane
is selected. The selected lane appears outlined in red. You can edit individual lanes using mouse
actions. Pausing the pointer over a lane displays helpful tooltips. Additional lane settings are available
in the Lanes tab of the Analysis Tool Box.

(Multichannel images only) Edits to lanes in a linked multichannel image apply to all channels. Edits
to lanes in unlinked multichannel images apply only to the channel edited.

To activate lane settings

1. Click Lanes and Bands in the Analysis Tool Box. Lane and Band settings become active. By
default the Lanes tab is selected.

2. (Optional) If Adjust Frame or Resize Frame appears blue, it is active. Click the active button to
inactivate it and exit Adjust Frame or Resize Frame mode so you can edit lanes.

To select lanes

u Do one of the following:

n To select a lane, click it.

n To select multiple, contiguous lanes, hold down the Shift key and click the first and
last lanes you want.

n To select multiple lanes that are not contiguous, Ctrl-click (PC) or Command-click (Mac) each
lane you want to select.

n To select all lanes, click Ctrl-A (PC) or Command-A (Mac).

To move one or more selected lanes

u Place the pointer on a selected lane and drag it to a new position.

All selected lanes move at once. Image Lab renumbers the lanes automatically.

To resize a lane

1. Select a lane.

White anchor points become visible.
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2. Point to an anchor on the side of the lane.

The cursor changes to a double-pointed arrow.

3. Drag the anchor to change the lane width to your liking.

To resize lanes to a width you specify

1. Select one or more lanes.

2. In the Lanes tab, enter a width in millimeters and click Set Width.

Image Lab resizes the width of the selected lanes to your setting.

To resize multiple lanes

1. Select one or more lanes.

2. Point to an anchor on the side of any selected lane.

The cursor changes to a double-pointed arrow.

3. Drag the anchor to change the lane width of all selected lanes to your liking.

To bend a lane from the middle

1. Select the lane you want to bend.

Point to the anchor in the center of the lane and drag the anchor to bend the lane right or left.

To tilt a lane at top or bottom

1. Select the lane you want to tilt.
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2. Point to the anchor at the top or bottom of the lane.

3. Drag the anchor to tilt the lane right or left.

To add an anchor in a lane

u In the center of the lane, right-click and then click Add Anchor.

Tip: You can adjust a so-called smiling gel using an additional anchor. To do so, see the
procedure, To adjust the lane frame shape, in Editing the Lane Frame on page 114.

To remove an anchor in a lane

1. Right-click the anchor you want to remove.

2. Click Remove Anchor.

Note: Top and bottom anchors cannot be removed.
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Editing the Lane Frame
Using Lanes commands in the Analysis Tool Box, you can adjust the shape of the lane frame and all
lanes it contains. You can also move, resize, or delete the frame. When selected, the frame appears in
red.

To access Lanes and Bands settings

u Click Lanes and Bands in the Analysis toolbox.

Lanes and Bands settings appear in the toolbox. The Lanes tab is selected by default.

To adjust the lane frame shape

1. Click Adjust Frame in the Lanes tab to select the frame.

2. Drag a corner of the lane frame and reshape or reorient the frame to your liking.

3. (Optional) If the gel is smiling, add or remove anchors to correct the shape.

4. Click Adjust Frame again to stop adjusting the frame shape.

To resize the frame proportionally

1. Click Resize Frame in the Lanes tab to select the frame.

2. Point to a corner anchor.

The cursor changes to a double-pointed arrow.

3. Drag a corner of the lane frame to resize frame height and width at the same time.

4. Click Resize Frame again to stop resizing the frame.

To resize frame height

1. Click Resize Frame in the Lanes tab to select the frame.

2. Point to the top or bottom border of the frame.

The cursor changes to a double-pointed arrow.

3. Drag the border to resize the height of the frame to your liking.

4. Click Resize Frame again to stop resizing the frame height.

To resize frame width

1. Click Resize Frame in the Lanes tab to select the frame.

2. Point to the right or left border of the frame.
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The cursor changes to a double-pointed arrow.

3. Drag the border to resize the width of the frame to your liking.

4. Click Resize Frame again to stop resizing the frame width.

To move the frame

1. Select the frame.

2. Place the pointer inside the frame.

The cursor changes to a four-directions arrow.

3. Drag the frame to a new location.
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Adding and Deleting Lanes
Using Lanes and Bands settings you can add or delete one or more lanes in an image.

Adding Lanes
By default, Image Lab adds lanes to an image using the width of Lane 1.

To add one or more lanes to an image

1. Click Add Lanes in the Lanes tab.

2. Click the location in the image frame where you want to add a lane.

3. (Optional) To add more lanes, click multiple places in the frame.

Image Lab adds lanes to the image in the locations you selected.

4. Click Add Lanes again to stop adding lanes.

5. Reposition the added lanes.

6. (Optional) If lanes overlap, move the added lanes to the left or right end of
the frame. The frame expands to accommodate the lanes, and the lanes are
renumbered automatically.
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Deleting Lanes
To delete one or more lanes from an image

1. Click a lane you want to delete.

2. (Optional) Ctrl-click each additional lane you want to delete.

3. Click Delete Lanes in the Lanes tab.

4. To confirm the deletion, click Yes in the dialog box that appears.

Image Lab deletes the lanes you selected.

5. Click Delete Lanes again to stop deleting lanes.

6. (Optional) Reposition the remaining lanes and resize the frame..

Copying Lanes
You can copy lanes from an image into any other image. Doing so is useful when several images
have been taken of the same sample with different stains. You can create the lane frame in the image
with a total protein stain and copy it to the other images. Copying lanes is especially useful when
normalizing unlinked multichannel images.

Note: Individual lanes cannot be copied.

A channel can contain only one lane frame at a time. When you paste lanes into a channel that
already contains a lane frame, Image Lab deletes the existing lanes and replaces them with the
copied lanes.

Note:When you copy lanes into a channel of a linked multichannel image, the lanes are copied
into all image channels including the composite image.

To copy lanes between channels

1. Click Lane and Bands and the Analysis Tool Box.

2. Select the channel or image that contains the lanes you want to copy.

3. In the Edit menu, click Copy.

4. Select the channel into which you want to paste the lanes.

5. In the Edit menu, click Paste.

A screen message notifies you that existing lanes in the selected channel will be deleted.
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6. Click Yes to continue.

7. Adjust the position of each copied lane in the frame individually.

Detecting Bands
Image Lab software detects bands in individual images.

To detect bands in an image

1. Click Detect Bands.

2. The band Detection dialog box appears.

3. Select band detection sensitivity and the lanes to which it applies.
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You can also detect bands in the Lane Profile window. See Adding and Deleting Bands — Lane
Profile on page 98.

Detecting Bands in a Multichannel Image

In a multichannel image, you must detect bands for each channel separately whether the multichannel
image is linked or unlinked. Multichannel view is a composite of the other channels. Bands cannot be
detected on a composite image. Detecting bands in multichannel view is less useful because
quantifying overlapping bands causes combined values from multiple channels.

Tip:When selecting bands in a multichannel image, leave the Band Detection dialog box open
and select and detect bands in each channel one at a time.

Setting Advanced Band Detection Options

You can also set specific parameters for band detection under Advanced in the Band Detection dialog
box.

Advanced values are set in relation to the band detection sensitivity you select under Detection
Settings. You can apply the specific parameters you set for the sensitivity level to all lanes or to a
specific lane.

If you later change the band detection sensitivity in Detection Settings, the advanced values change in
relation to the new sensitivity levels. In this case, you might have to reset advanced parameters to the
original values.
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Advanced Detection Options

n Sensitivity— determines the minimum optical density to be defined as a band. The higher the
sensitivity value, the lower the minimum signal intensity and the more bands will be detected.

If the sensitivity is set too high, background staining might be detected as bands. If the setting is
too low, bands of interest might not be detected.

The default sensitivity setting is 10.0. If the gel has faint bands (that is, if the optical density is less
than 0.05, and counts are less than 2,000), consider increasing this value to 20.0.

n Size Scale— distinguishes between trends in signal intensity and random intensity fluctuations.
Size scale is the number of pixels in a vertical column taken together to determine whether a
band is present.

The Size Scale parameter uses the size of objects in the image to determine the nature of those
objects. If a gel image has high levels of background noise, a larger size scale is appropriate. At
low noise levels, a smaller value is preferable. You can also increase the size scale if the gel has
only a small number of thick bands scanned at high resolution.

n Noise Filter—minimizes the number of small fluctuations (or noise) in the image that are called
bands while still recognizing larger features (the real bands). This filter becomes especially
important at higher sensitivity levels.

The noise filter value refers to the size of the filter in pixels (for example, a value of 2.50 equals a
filter size of 2.50 x 2.50 pixels). Features smaller than the filter size are not recognized as bands.
Entering a noise filter size of zero turns the filter off completely.

If band detection identifies doublets as single bands, decrease the noise filter setting or increase
the sensitivity level, or do both.

Tip: You can decrease the Size Scale parameter instead of the noise filter to improve the
detection of closely spaced bands. However, if you decrease both the noise filter and the size
scale, the fuzziness around bands might be mistakenly detected as separate bands.

n Shoulder— band detection tries to distinguish shoulders as separate bands. When looking at a
lane trace, these bands appear as flat or gently sloping abutments to darker, better-defined bands
(that is, there is no dip on the trace between the two bands). Increasing the shoulder sensitivity
results in more shoulders being detected as bands. Changing this setting to zero results in no
shoulders being recognized as separate bands.

If band detection calls a doublet a single band, check the lane trace to see if a dip appears
between the peaks of the two bands. If there is no dip, increasing the shoulder sensitivity value
will help resolve the two bands.

n Normalize Sensitivity— compensates for differences in intensity between lanes.
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The intensity of each lane is determined by the darkest band in that lane. For example, suppose
that in all but one of the lanes the darkest band has an intensity of 50,000 counts. In the light lane,
the darkest band is only 25,000 counts. With normalization, band detection is twice as sensitive
when processing the light lane, improving the detection of faint bands.

Note: This setting does not normalize for band quantitation.

n Band Limit— enables you to limit the number of bands that will be detected in each lane,
reducing the need for later editing.

Editing Bands
You can optimize the bands in an image using the settings in the Bands tab:

Add—manually add a band to a lane.

u Click Add, and then click inside a lane. Image Lab locates a faint band close by.

Tip: To view faint bands more easily, darken the entire image. Click Image Transform in the
image toolbar and adjust the image with the sliders in the box that appears.

Delete— delete a band from a lane. Useful for removing bands not relevant to the analysis. Click
Delete, and then click the band you want to remove.

Adjust— adjust the height of a band.

u Click Adjust to display boundary lines above and below each band.

n Move the pointer over a boundary line until the cursor changes to a double-pointed arrow.

n Move the boundary line to adjust the band height. Image Lab repositions the band and
recalculates its center.

Note: You can also edit bands in the Lane Profile window. For information, see Lane Profile
on page 93.
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Normalizing Volume Data
(Multichannel images only) Normalizing the volume data in a multichannel image is most useful in the
following cases:

n The lanes are loaded with the same volume, but you do not know the total protein in each lane.

n Pipetting errors result in variations in the lane volumes.

n Differences occur in the transfer of protein from a gel to a membrane.

You can correct for these differences when normalizing the volume data.

u Select one of the following settings under Normalization in the Lanes tab:

n Total Lane Protein – calculates the normalization factor based on one lane in the
normalization channel.

n Housekeeping Protein Bands – calculates the normalization factor based on a single band
of housekeeping protein. To obtain accurate results, the housekeeping protein must be
stable and impervious to the treatments in the experiment. The housekeeping protein must
also be the same in pretreatment and post-treatment.

Both settings use the normalization factor to calculate the normalized volumes in the lanes for all
channels.
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Normalization Settings
Normalization settings appear in the Lane and Bands tabs of the Analysis Tool Box under the Lanes
tab.

By default, the first non-standard lane is selected as the normalization lane.
However, you can select any non-standard lane as the normalization lane.

Note: If a standard lane is selected that conflicts with the normalization
lane, Image Lab resets the selection to the default normalization lane.

You can select one of the channels in a multichannel image, for example:

For a single channel or two-channel image, you can select Add channel in
the Normalization Channel dropdown list to drag entries from other open
images into the normalization data channel.

For more information, see Add a Channel to a Single Image on page 130.

Normalizing Data — General Steps
General steps outline the process of normalizing volume data. Detailed information in the following
sections guides you through these general steps:

n Detecting lanes in a channel

n Adjusting the lanes

n Detecting bands

n Subtracting extraneous background

n Removing compromised data

n Viewing the data in an analysis table
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Detect Lanes in Channels
(Multichannel images) You can detect the lanes in a multichannel image automatically or manually. If
the multichannel image consists of unlinked images, ensure that the detected lanes are correctly
mapped for each channel.

Tip: You can copy lanes in one channel to map lanes in another channel.

To detect lanes in channels

1. Under Lane Finder, click Automatic or Manual.

Image Lab detects the lanes.

2. (Optional) If the images are unlinked, ensure that the detected lanes are
correctly mapped to each channel.
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Adjust the Lanes
Important: After lanes are detected, review lane borders to ensure that each lane encompasses
all the protein in the lane and lanes do not overlap.

In the image shown, lanes were detected automatically. Some of the lanes exclude material that
should be included.

Note: Image Lab automatically excludes the lanes you specify as standard lanes from
normalization.
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The image can be corrected by adjusting lanes using Lane and Bands settings. The lanes in the
image shown were corrected by slightly widening them to include the relevant material:
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Detect the Bands
Settings in the Band tab enable you to detect the bands in image channels.

Note: Detecting bands on the normalization channel is not recommended when total lane protein
normalization is selected. Detecting bands using this normalization method generates large
amounts of superfluous data in the analysis table.

To use a housekeeping protein to calculate the normalization factor, you must isolate this protein in
the image.

u Remove all bands other than the housekeeping protein from the image.

The normalization channel should have only one detected band in each lane.

To exclude all other bands from the calculation

u Click Delete Bands in the Bands tab. Delete each band you do not want.
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Subtract Extraneous Background
The lane volume data is background subtracted.

1. Review the background subtraction applied to each lane in the Lane Profile window.

2. Verify that an equivalent background profile is being subtracted from each lane in the
normalization channel so the normalization factor is accurate.

For more information, see Volume Background Subtraction on page 146.

Remove Compromised Data
u Exclude from the analysis lanes that have any of the following characteristics:

n Empty lanes— the first nonstandard lane in the selected channel is used as the
normalization factor against which all other lanes in all channels are compared. If the first
nonstandard lane is invalid (for example, an empty lane), delete it from the channel or select
a different lane as the normalization lane.

n Lanes contain saturated pixels— check the images for saturated pixels, indicated in red.
These points can neither be read nor used in quantification.

n Poor transfer quality— check the quality of the transfer. If the transfer is poor with splotchy
or blurred areas, delete the lanes.
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View the Data in the Analysis Table
The first nonstandard lane in the selected channel is used as the normalization factor against which
all other lanes in all the channels are compared. Normalization values are calculated based on the
total background-corrected signal in the selected channel.

The analysis table displays the uncorrected and normalized volumes, as well as the normalization
factor used to calculate the normalized volume.

The Lane Statistics tab displays detailed lane data:

Tip: You can hide the normalization channel from the analysis table. (See Multichannel View
Settings on page 78.)
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Add a Channel to a Single Image
Normalization settings can be used only for multichannel images, but you can add a channel to a
single image using a normalization setting. Doing so results in a multichannel image. Then you can
normalize the data in the usual way. Images in the multichannel image must have the same aspect
ratio. Images created using different imaging systems or cropped images might not have the same
aspect ratio as the first image. Image Lab checks the aspect ratio of each image. Images with aspect
ratios different from that of the first image do not appear in the list of Compatible Open Images.

To add a channel to a single image

1. Click Lane and Bands in the Analysis Tool Box.

2. In the Lanes tab, under Normalization Channel, select Add channel from the dropdown list.

The Add Normalization Channel dialog box appears. Images with compatible aspect ratios are
listed in the left pane.

The image on screen when you clicked Add Channel appears in the dialog box under Channel to
Normalize. This image is the first channel in the multichannel image. Its name appears in the
Sample data box.

3. (Optional) To add a second image, drag an image in the Compatible Open Images list into the
Normalization Data box or click Browse to find the image you want.

The image you added appears in the Channel to Normalize box.

4. Click OK.

The Auto-Analysis dialog box appears.

5. Select a sensitivity level for bands and click OK.

A multichannel image of the two channels appears in the workspace. The Normalization channel
is labeled Norm.

130 | Image Lab Software



Molecular Weight (MW) AnalysisTools

Molecular Weight (MW) Analysis Tools
Molecular Weight Analysis tools enable you to determine molecular weight (or base pairs, when using
nucleic acid gels) by comparing a test sample with known standards.

Note: Before you can use the Molecular Weight Analysis tools, you must detect the lanes and
bands in the image.

You can view each band’s molecular weight in the molecular weight column of the Lane and Band tab
in the Analysis Table.

You can also display the molecular weight of the bands on the gel image by opening the Display Gel
Options dialog box and selecting Mol. Wt. in the Attribute dropdown list under Band Attributes. (See
Displaying Gel Images on page 68 for information about displaying band attributes.)
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Changing Molecular Weight Standards
You can change the standards to standards more relevant to your samples.

To change standards

1. Click Change to open the Manage Standards box.

2. Choose ar standard or add one.

Standard Lanes
By default, standard samples are placed in the first and last lanes. You can specify other standard
lanes by selecting the box below each lane or by entering the standard lane numbers separated by
commas in the MW Analysis Tools dialog box. In the Lane and Bands view, the notation Std below the
lanes identifies them as standard lanes. In the Molecular Weight Analysis view, a check mark appears
below each standard lane.
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Molecular Weight Analysis in Single-Channel Images
Three standard lanes appear in the image shown (lanes 1, 16, and 17). A check mark appears below
each standard lane. The molecular weights of the bands in the standard lanes appear on both sides of
the lane frame. The red lines running across the lane frame identify the location of the bands in the
standard lanes. You can use these lines to determine where the bands in the other lanes fall relative
to the bands in the standard lanes.

Names of the standard lanes appear as labels above them.
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Values for the molecular weight in a standard lane appear in bold. In the table shown, the values for
the first lane appear in bold. (Lanes 16 and 17 are not included in the image; their values would also
appear in bold.) The molecular weight of the bands in the remaining lanes is calculated relative to
these standards.

Molecular Weight Analysis in Multichannel Images
Molecular weight analysis is performed differently in multichannel images depending on whether the
channels of the image are linked or unlinked. If the channels are linked, the standard lanes are
synchronized across all channels. If the channels are unlinked, each channel has its own standard.

When you select the standard lane in one channel of a linked multichannel image, the same lane is
selected as the standard in all other channels. The combined data in the multichannel image are used
to detect the bands in this standard lane. These bands are synchronized across all channels. All the
bands in all the channels are calculated using the same standard lane. If you deselect this lane as the
standard, the bands in the standard lane are deleted from all channels, including the multichannel
image.

In unlinked multichannel images, each channel is treated like a single channel image. You select a
standard lane for each channel and the molecular weight is calculated only for the bands in that
channel.

In the next image, lane 1 in the linked multichannel image is selected as the standard lane for all
channels. Because the images are linked, the same molecular weights for the standard lane and the
same red lines showing the location of the bands in the standard lane appear in all channels.
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The molecular weights of the bands in the three channels are calculated based on standards
established in lane 1 and appear in the analysis table.

Regression Methods
Three regression methods are available to generate the volume quantification curve used for absolute
quantity:

n Linear (semi-log)

n Point-to-point (semi-log)

n Cubic spline

The data for volume standards appear in the Absolute Quantity column of the Volume Table.

To display the standard curve

1. Click Standard Curve on the toolbar.
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2. In the Standard Curve dialog box, select the Volume Standard Curve tab.

Note:When the Force Through Origin checkbox is selected, the standard curve graph starts at
0,0, regardless of the best curve fit. See Appendix A, Regression Calculation Methods, to learn
how each regression method is calculated.

Quantity Tools
You can quantify bands in test samples automatically in the Relative or Absolute tab under Quantity
Tools in the Analysis Tool Box.

Relative Quantity Tab
To compare the relative quantities of bands

1. Select the Relative tab under Quantity Tools.

2. Click Select.

3. Click the band you want to use as a reference. A small R appears near the band you selected.
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To review the relative quantities of bands

u Go to the Rel. Quant. column of the Analysis table (Lane and Band tab). The relative quantity is
the ratio of the band volume divided by the reference band volume.

All other bands now display numerical values that are relative to the reference band. If the reference
band value is 1.00, values higher than 1.00 indicate that the band quantity is greater than the
reference band. Values lower than 1.00 indicate the band quantity is less than that of the reference
band.

Absolute Quantity Tab
Absolute quantification is used to quantify bands based on known standard bands using a calibration
curve.

To calculate the absolute quantities of the bands

1. Select the Absolute tab under Quantity Tools.

2. Click Select.

3. Select at least two standard (known) bands and assign quantity values. A small appears, circled
in red, near each band you selected.

User Guide | 137



Chapter 6 Analyzing Images

The values appear in the Standard Bands table. The greater the number of
known bands and the wider the range of their values, the more accurate
the absolute quantity calculation of the unknown bands will be.

Note: Any standard band selection can be deleted. Select the entry in
the Standard Bands box and then click Delete.

4. Select a unit of measure in the Units dropdown list.

5. Select a regression method in the dropdown list.

Consider the following guidelines when selecting a method.

Linear— generates a straight line that is the best fit of the values you
provided and is preferred in most cases.

Point-to-point— generates a curve in which each data point is connected
directly to the next, regardless of the shape of the resulting curve.

Cubic spline— generates a smooth curve that connects each data point.
At least four standard points are required to use this method of least-
squares polynomial fits.

6. Click Standard Curve on the toolbar and select the Absolute Quantity
Standard Curve tab.

Regression
Method

Min Number
Standard Bands

Min Nr with Force
Through Origim

Linear 2 1
Point-to-point 2 1
Cubic spline 5 4

The calibration curve appears. Standards are represented by green triangles. Unknown values
are represented by red triangles.

Note: Selecting the Force Through Origin checkbox always starts the standard curve graph at
0,0, regardless of the best curve fit.
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Note: Clicking the Standard Curve table generates a crosshair tool that displays the
numerical values associated with the placement of the cursor in the graph.
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Annotation Tools
You can annotate results with text and arrows to emphasize areas of interest.

Add Annotations
Text— enables you to add text annotations to images to emphasize important details.

1. Click Text, and then click an area on the image where your comment should be inserted .A box
appears with a dotted-line border.

2. Type your comment in the box.

Tip: To add a new line to the box, place your cursor where you want the break and press
Shift+Enter.

To move the box

u Click and drag the box to change its position.

n Arrow— enables you to add arrows to images to emphasize important details. Click where you
want the arrow to start and drag to stretch the arrow point to the location you want to emphasize.
To move the arrow on the image, click the middle of the arrow and drag it to the new position.
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To change where the arrow points

u Click either end of the arrow. Square boxes appear. Drag a box to change the length or
orientation of the arrow.

Note: In multichannel images, you can add annotations in all the channels. Each annotation,
including the merged channel, is channel specific.

Alignment
The alignment buttons enable you to align multiple annotations, such as lane numbers, which you
have manually added.

To select multiple annotations

u Press the Ctrl key (Command key on a Mac) and click each item or drag a selection box around
them.

Note: In multichannel images, you can also copy annotations from one channel to another using
the same method.
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Text Properties
You can change the type size and font of your text annotations.

Font

1. Click the box you want to change.

2. Open the dropdown Font menu to show all fonts installed on your system.

3. Select a new font for the text annotation.

Size

1. Click the box whose font you want to resize.

2. Open the dropdown Size list to increase or decrease the size of the text.

3. Set the font size from 6 to 72 points using the dropdown list.

Color
You can change the color of text annotations to make them visible with any color scheme, and
emphasize them further by adding a color to the annotation’s background, which is invisible by
default.

To change the color of multiple items

u Press the Ctrl key and click each item.

Foreground

n Click a text annotation or arrow. This activates the Foreground box, so you can select a
foreground color from the dropdown list.

Background

n Click a text annotation. This also activates the Background box so you can select a
background color from the dropdown list.
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Rotate
To rotate text annotations 90° left or right

u Click the Rotate buttons under Imaging Tools in the Analysis Tools Toolbox.

Volume Tools
Volume tools enable you to manually quantify features on a sample image when automated lane and
band analysis is not appropriate or possible, such as in dot blots.

The analysis table displays the color-coded volume drawn for each channel in a multichannel image.
In multichannel view, you can draw a volume on individual panes, but you cannot draw a volume on
the Multichannel pane.

You can use Volume tools to quantify the signal intensity of bands, spots, arrays, and other image
data. Define an area of interest by surrounding it with a shape. You can choose Rectangle, Round,
Freehand, or Lane.
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A default label appears inside the shape drawn. The volume label is assigned a sequential number
and can be one of three types:

n U — unknown

n Std — standard

n B — background

Each new volume you create initially has a red border, which indicates that the volume is selected.
When you click elsewhere on the image, the border changes to blue, indicating that the volume is no
longer selected.

Note: Double-click a volume area to change its properties.

To review data for the volumes

u Open the analysis table and select the Volume tab.

Volumes are listed based on their number and/or the associated information per volume. For
information, see Volume Measurements on page 92.

Note: In multichannel images additional column bars, channel numbers, and volumes are
color-coded to match their channel color.
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Volume Types
You can define the volume type (unknown, standard, or background), the quantity of standard
volumes, or enter a custom name to replace the default label.

Unknown volumes are volumes you want to quantify.

Standard volumes are used for absolute quantities. For information, see Absolute Volume Quantity on
page 148.

Background volumes are used to remove the background from the volume calculation of non-
background volumes. The result of volume background subtraction appears in the Adjusted Volume
column of the analysis table (Volume Table tab).

Note: Assign this volume type only when using global background subtraction.
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Volume Background Subtraction
When you draw a volume, some nondata background signals might be included inside the volume.
These background signals usually have an intensity value that you do not want to include in your
volume quantification. There are two methods of calculating this background intensity for volumes:
local and global.

n Local— local background subtraction calculates a separate background intensity for each
unknown and standard volume you create. For each volume, the intensities of the pixels in a 1-
pixel border around the volume are added together and divided by the total number of border
pixels. This gives an average intensity for the background around each, which is then subtracted
from the intensity of each pixel inside the volume. If the background value is greater than the pixel
value inside the volume, the background-adjusted quantity of the volume can be <0. In this case,
redraw the border for this volume.

n Global— global background subtraction calculates a single background intensity for the entire
gel. This average background intensity is then subtracted from all the volumes in the gel. The
average intensity of the pixels in the background volume is calculated and subtracted from each
pixel in all standard and unknown volumes. Therefore, it is not necessary for the background
volume area to be the same size as your unknown.

To calculate global background subtraction

1. Use one of the Volume Tools to create a volume in a representative background region of your
image (that is, a nondata region similar to the background surrounding your data).

2. Double-click the volume. The Volume Properties dialog box opens.

3. Select Background in the dialog box.

Keep the following points in mind:

n If you select Global in the Volume Tools toolbox but do not define a background volume as
described, no background subtraction is performed.

n If you create more than one background volume, all the pixels in the background volumes are
used to calculate the average background. By default, background volumes are named B1, B2,
and so on based on the sequence in which they were created.

n If the region you defined as background has a higher average intensity value than the data object,
you obtain a negative value for theadjusted volume in the analysis table. If this happens, select a
new background region with less intensity thanthe data object.
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Relative Volume Quantity
You can choose any one volume as a reference volume by selecting the Reference Volume checkbox
in the Volume Properties dialog box. The reference volume is indicated by an asterisk on the volume
label, for example, U1*. Relative quantities are displayed in the Relative Quantity column in the
analysis table (Volume Table tab). The relative quantity is the ratio of the background-adjusted volume
divided by the background-adjusted reference volume. All other volumes now display numerical
values relative to your reference volume. Values higher than 1.00 indi te that the volume is greater
than the reference volume. Values lower than 1.00 indicate the volume is less than the reference
volume.

Regression Methods
Three regression methods are available to generate the volume quantification curve used for absolute
quantity:

n Linear (semi-log)

n Point-to-point (semi-log)

n Cubic spline

The data for volume standards appear in the Absolute Quantity column of the Volume Table.

To display the standard curve

1. Click Standard Curve on the toolbar.

2. In the Standard Curve dialog box, select the Volume Standard Curve tab.

Note:When the Force Through Origin checkbox is selected, the standard curve graph starts at
0,0, regardless of the best curve fit. See Appendix A, Regression Calculation Methods, to learn
how each regression method is calculated.
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Absolute Volume Quantity
Note: Absolute volume quantity analysis is not available for multichannel images.

If you have drawn the volume around an object of known quantity, you can use it to calculate the
quantity of unknown volumes. The quantities of unknown volumes are calculated based on the
standard volumes and the selected regression method.

To classify a particular volume as a standard

1. Double-click the volume to open the Volume Properties dialog box.

2. Select the Standard option button and enter the quantity in the Quantity box.

3. Click OK to close the dialog box.

By default, standard volumes are named S1, S2, and so on, based on the sequence in which they are
created.

To review the regression curve

u Open the Standard Curve dialog box and select the Volume Standard Curve tab.

Alignment
Align volumes by using the appropriate alignment button. To select several volumes, Ctrl-click each
one, then select one of the alignment buttons. Hover over any of the six alignment buttons to display
its function (Align Left, Align Right, and so forth).

Copy and paste selected volumes by pressing Ctrl+C to copy. Press Ctrl+V to paste.

When you click the Standard Curve button on the toolbar, a chart displays all unknown and standard
quantities.
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Chapter 7 Generating Reports
After viewing results, you can generate a report that displays the analyzed gel images, all of the
settings used in the protocol, and as much information about the data as you want to include.

You can choose print settings within the Report Settings dialog box in the Edit menu or by clicking
Report in the main toolbar.

Report
To produce a preview of the report

u Click Report on the toolbar.

Use the following dialog boxes to customize the content in reports. Doing so does not modify the data
from the analysis.

Report Options

Use this dialog box to customize the content of the report.
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General Tab

The General tab includes the following options:

n Include Gel Image— specify whether the image is included in the report.

If the image is included, the following options determine which overlays are displayed on the gel
image:

o Show Lanes and Bands

o Show Volumes

o Show Annotations

o Include Unannotated Image

When you select this checkbox, both the annotated image (if available) and unannotated
images are printed in the report. The unannotated image precedes the annotated image in
the report.

Note: If you disable the other checkboxes in the Include Gel Image group, the Include
Unannotated Image checkbox is automatically disabled.

n Image Info— specify what information is included in the report.

o Acquisition Information

o Analysis Settings

o Image Information

o Notes
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n Signature History— details on when and why a secure document was signed (applies to
Security Edition only)

If a secure document has been signed, the user name, the date and time of the signature, and the
reason for signing are all included in the Signature History section. If a document has not been
signed, this section is omitted from the image report.

Lane and Band Table Tab

The Lane and Band Table tab includes the following settings:

n Include Lane and Band Table— specify whether to include the Lane and Band table in the
report.

n Lanes to show— specify which lanes to display in the report.

n Show Lane Profile— specify whether to display the Lane Profile view.

n Print one lane per page— specify whether all lanes are printed on one page or whether each
lane is printed on a separate page (adds a page break after each lane).

n Show Lane Profile— include the lane profile for each lane.

n Not Displayed/Displayed— remove columns that you do not want to display in the report. By
default, the report displays all columns from the Lane and Bands table.
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Volume Table Tab

The Volume Table tab includes the following settings:

n Include Volume Table— clear to exclude this information from a report.

n Not Displayed/Displayed— remove columns that you do not want to display in the report. By
default, the report displays all columns from the Volume table.
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Lane Statistics Tab

In the Lane Statistics tab,you can choose to display the following information:

n Channel

n Lane number

n Adjusted total band volume

n Total band volume

n Adjust total lane volume

n Total lane volume

n Background volume

n Normalization factor
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Print Report

Click the Print Report button to print the report.

Print Report to a PDF File

The Print Report to .pdf File button opens a Save dialog box so the PDF file can be saved on your
system.

Adjust the Printer Settings

The Printer Settings button accesses options for paper size, orientation, and page margins.
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The most convenient way to archive complete information about experiments is to produce reports.
However, it is possible to export only gel images or analysis table data for analysis in different
programs, such as Quantity One and ImageJ software. It is also possible to export only files for
presentation or publication.

Exporting Gel Images
When you export gel images, you can choose an option that suits your purpose:

n Export displayed image data to a publication (choose Export for Publication).

n Export raw image data as a 16-bit .tif file (choose Export for Analysis).

n Export image data to PulseNet. Doing so reduces the image to a .tif file (8-bit), limits its resolution,
and restricts its file size to 300 Kb.

n Export lane and band tables as well as volume tables to a spreadsheet program or to a file.

To select an export option

u On the File menu, click Export and choose an option in the context menu.
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Exporting Gel Images for Publication
Choose this export option only when you want to export visual information to presentation or word
processing software, such as PowerPoint or Word. You can select .bmp, .png, .jpg, or .tif format. The
gel displays with the lanes, bands, and annotations that appear on screen.

(Multichannel Images) Image Lab software exports the active channel in a multichannel image. Select
the channel you want to publish before you export the image.

Before You Export
You can zoom in on an area in a current view and export only that area or export the entire image.

You can exclude annotations or overlays by clicking Display Gel Options in the Display Toolbox to
access the appropriate settings.

156 | Image Lab Software



Exporting Gel Images for Publication

To export a displayed image to a file

1. Select File > Export > Export for Publication.

The Export For Publication dialog box appears.

2. Do any of the following:

n Select the entire image or the current view

n Select the resolution or specify a custom resolution

n Specify the publishing dimensions

n View the resulting published image size and dimensions

3. When the image is acceptable, click Export and save the image.
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Exporting Gel Images for Analysis
To export an image for analysis

u Select File > Export > Export for Analysis.

This procedure exports the raw data only as a 16-bit .tif file.

Note: 16-bit .tif images are not compatible with all image viewers.

The image might require contrast adjustment when it is imported into analysis software. This option
creates a file that can be analyzed in other programs such as Quantity One and ImageJ.

Note: (Multichannel images) Image Lab software exports the separate channel images but not
the composite image. Each exported channel image is saved with its application name appended
to the filename you select.

Exporting Gel Images to PulseNet International
To export an image to PulseNet International

u Select File > Export > Export for PulseNet.

Image Lab reduces the image to an 8-bit .tif image file. Resolution is limited and file size is
restricted to 300 Kb.

Note: Export for PulseNet is not available for multichannel images.
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Exporting Lane and Band Tables to Excel
If you have Excel (or Numbers on a Mac) installed on your computer, you can export the data to your
spreadsheet application.

To export the data to Excel (or Numbers)

u Select File > Export > Lane and Band Table to Excel.

The exported data appears in a table open in your spreadsheet program.

Tip: You can then select Save As and produce other formats.

Exporting Volume Tables to File
To export an image as a CSV file

u Select Export > Volume Table to File.

Image Lab exports the image as a comma-separated values (CSV) file so the data file can be opened
in a database application.

Screenshot Tool Export
Use the Screenshot tool on the toolbar to capture an image open in the workspace to the clipboard or
to save it to a file (.bmp, .gif, .jpg, or .png).
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Image Lab software provides the following types of logs:

n System log— records events related to running Image Lab, including enabling or disabling of
secure mode and the users who log on to or log off of Image Lab.

n Document log— (Security Edition only) records events related to the creating and modifying of
secure protocol and image files.

n Instrument log— records events related to the operation and calibration of the instrument.

Viewing the System Log
Events related to running Image Lab, including enabling or disabling secure mode and users logging
on or logging off from Image Lab, are recorded in the system log.

To open the System Log Viewer

u In the View menu, click View System Log.
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Viewing the Document Log
The View menu displays a list of logs for each open document. The document log captures
information about creating and editing the Image Lab protocol and image files.

Note: Document logs are viewable only in Image Lab Security Edition, and only on Windows-
based computers. Document logs are not viewable on the Mac.

The document log captures changes from

n Image tools

n Lane and bands tools

n Normalization tools

n Molecular weight tools

n Quantity tools

n Volume tools

You can view the document log for any open file, including a previously saved file or a newly created
protocol or image file open on your desktop but not yet saved.
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To open the Document Log Viewer

u In the View menu, click the document log you want to view.

An example document log is shown next.

Viewing the Instrument Log
When your computer is connected to an instrument, an instrument log records events related to the
operation and calibration of the instrument.

User Guide | 163



Chapter 9 Software Logs

Displaying Log Data
The display toolbar appears above the log.

Displaying Data Columns in Logs

By default, the logs display the following columns:

n Date and time

n User

n Level — the security role of the user

n Domain — domain where the current user is logged in

n Type — the type of event

n Description — the event captured

n Reason (Secure Mode only) — the reason a document was signed

You can change your view of any log by displaying or hiding data columns.

To display or hide columns

1. In the View menu, click View System Log.

2. Click the Display log viewer options icon (the leftmost icon).

3. In the Display Column Options dialog box, use the arrow keys to move columns between the Not
Displayed and Displayed lists.
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4. Click OK.

Filtering Data in Logs

For Image Lab logs, you can filter the entries in the following columns:

n Date and time

n User

n Type

For example, if you set the filter in the Type column to File, Image Lab displays only the rows in which
Type is equal to File.

Setting Filters in Logs

By default, the log opens with all event types displayed. You can filter most event type columns.
However, some columns cannot be filtered (for example, Description and Reason columns).

To filter column entry types

1. In the log, right-click the heading of the column that you want to filter.

Filter options appropriate for the column appear in the Select filter values dialog box.

Note:When you select a column that cannot be filtered, the dialog box does not appear

2. Select the filter values that you want to display in the column and click OK.

The log displays the values you selected for the column.

Displaying or Hiding Columns

3. Click the Display Filter options icon in the toolbar.

The Select filter values dialog box appears.
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4. Select a value and click OK.

Tip: You can filter multiple values.

Removing filters in logs

The Remove all filters icon clears all filters on all columns.

Each filterable column also has a Remove filters icon that removes the filter for that column only.
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Collapsing or Expanding Data Rows

You can expand the size of rows in any log to display the full content of the row or collapse the row
size to display more rows in the table. The icon toggles between collapse and expand.

To display the full content of a row

u Click the Collapse or expand rows icon to expand the row height. The row adjusts to fit the text of
the longest entry.

This action expands all rows in the log where an entry is longer than the width of the column.
Rows that do not wrap are not affected.

To display more rows in the table

u Click the Collapse or expand rows icon to collapse the row height to the default height setting.

This action collapses all rows in the log to display data on a single line.
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Exporting Logs
In the log viewer, you can

n Copy log entries to the clipboard— copies the log entries to the clipboard, enabling you to paste
them into a word processing or presentation application.

n Export log entries to a file— exports the log entries as a CSV file that can be opened in a
database application.

n Export log entries to Excel— exports the log entries to an Excel file where you can use Excel’s
sorting and formula functions to manipulate the data. If Excel is not installed on your computer,
this feature is inactive.

To export a log file

1. In the View menu, click the log you want to export.

2. Click one of the icons to export the data in one of the supported formats.
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Printing Logs
Log data can be sent to a printer or saved to a PDF file.

To print a log

1. In the View menu, click the log you want to print.

2. In the log viewer, click Print log.

The Log Print Preview window displays the contents of the log file.

In the Log Print Preview window, you can do any of the following:

n Click Print log to print the log to a printer.

n Click Print log to PDF to save the log to a PDF file.

n Click Adjust printer settings to prepare the file for printing.
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21 CFR Part 11
Image Lab Security Edition is a module in the Bio-Rad’s Image Lab software that assists users in
meeting the U.S. Food and Drug Administration’s regulations on good lab practices in the
pharmaceutical and biotechnology industries. The Security Edition enables system administrators to
ensure that Image Lab operates in compliance with Title 21 of the Code of Federal Regulations (CFR)
Part 11in a closed system. A closed system is defined as “an environment in which system access is
controlled by the persons who are responsible for the content of electronic records that are on the
system” (Section 11.3 (b) (4)).

Important: Image Lab Security Edition is not supported on the Mac.

ChemiDoc Touch and 21 CFR Part 11 Compliance
The ChemiDoc Touch imaging system running Image Lab Touch Software 1.2 or earlier does not
support the acquisition of images in secure mode, and any reference to the creation of secure
documents does not apply.

However, Image Lab Touch, running on the ChemiDoc Touch, ChemiDoc, or ChemiDoc MP imaging
systems, can export secure images but do not support signature or log viewing. Secure files exported
to Image Lab software can be opened in secure mode and signed. Logs from these files can be
viewed in Image Lab. For more information on this feature, see Unsecured Documents on page 175
and Signing Documents on page 176. For information about the logs that document these actions, see
Document Logs on page 177.

Administering Security Controls
The security controls built into Image Lab Security Edition must be properly configured and
administered by the system administrator(s) in your organization in order to be secure and in
compliance with 21 CFR Part 11.
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Establishing Policies and Procedures for Compliance
Bio-Rad makes no claim that Image Lab Security Edition software is CFR-compliant in and of itself,
nor does the company guarantee compliance for the user. Your organization must establish policies
and standard operating procedures that work in conjunction with the tools provided by Bio-Rad to
ensure compliance with 21 CFR Part 11.

Standard Mode versus Secure Mode
Image Lab Security Edition can be run in either of the following modes:

n Standard Mode— in this mode, there are no restrictions on controlling the instrument, operating
the software, or changing the documents.

n Secure Mode— in this mode, in addition to the features available in standard mode, security
features are enabled, including document signing, the use of Write Once folders, and log creation.

When Image Lab is in secure mode, a padlock symbol appears in the left corner of the status bar.
If no padlock is present, the software is running in standard mode.

When Image Lab is installed, by default it is set to run in standard mode. It continues to run in this
mode until a user with Image Lab Administrator privileges enables secure mode. This chapter
assumes you are running the software in secure mode unless noted.

User Names, Groups, and Roles
To run Image Lab Security Edition in secure mode, you must log in with a user name and password.
The Microsoft Windows system administrator usually creates the user names and passwords. The
Image Lab administrator defines the groups with which the Security Edition roles will be associated.
there are four default roles in Image Lab Security Edition. Each role is associated with one of the four
default Image Lab user groups, and each user is assigned a role that gives the user access to specific
features in the software.

Note: System administrators can change the user group names, if necessary, to meet their
company standards. For more information about setting up groups, user names, and passwords,
see User Accounts on page 181
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User Group
Image Lab
Role Description

TDS_
Administrator

Administrator Administrators can enable or disable secure mode and view log
files. They do not have access to other features.

TDS_User Supervisor Supervisors have full access to all application features and
functions and can also sign files. They cannot enable or disable
secure mode.

TDS_Tech Clinician Clinicians can perform instrument operations and view log files
and sign files. They do not have access to other features.

TDS_Guest Reviewer Reviewers can view log files and can also sign files. They do not
have access to other features.

Table 7.
Image Lab Security Edition groups and roles

Role Restrictions
Your role determines which features of the security edition you have permission to use. If you attempt
to perform an action that is not permitted for a user in your role, you will see an error message. In
some instances the user’s role determines which Security Edition features are visible and/or enabled.
Therefore, you might not see all of the features described in this chapter.

Table 8 lists the Image Lab Security Edition functions that each role has permission to perform.

Function Administrator Supervisor Clinician Reviewer

Enable/disable secure mode X

View log files X X X X

Enable/disable write once
support

X

Set up and recalibrate the
instrument

X

Create new protocols X

Open existing protocols X X X

Table 8. User access to features by role
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Function Administrator Supervisor Clinician Reviewer

Run protocols X X

Edit protocols X

Create new images X X

Open existing images X X X

Edit images X X

Analyze images X X

Sign documents X X X

Starting Image Lab Security Edition
When secure mode is enabled, you are prompted to log on when you start the Image Lab application.

To start Image Lab in secure mode

1. Click the Image Lab icon to start the application.

2. In the Log on to Image Lab dialog box, enter your user name and password.

3. Click OK.

Note: If you have any questions or problems logging on, see your system administrator.

Electronic Records
Image Lab Security Edition enables you to create secure electronic records as defined by 21 CFR Part
11. In Image Lab, the following are electronic records:

n Protocol files

n Image files
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n Document log files

n Instrument log files

n System log files

Unsecured Documents
Note: Starting with version 2.0, Image Lab Touch exports secured documents. Information in this
section does not apply to imagers running Image Lab Touch 2.0 or later.

Image files created with the ChemiDoc Touch imaging system running Image Lab Touch 1.2 or earlier
are unsigned, unsecure documents. Unsecure documents remain unsecure. When you open these
files in secure mode, you can make changes to these files and save them without restrictions. A
document log is generated for changes to these files, but the log is not viewable in standard mode.
You must log in to secure mode to see the log.

You can also open unsecure documents in secure mode and sign them. You can make changes to
these files and save them as secure documents. The original unsecure document remains unsigned
and unsecure. The new document is saved as read-only with an incremental revision number and
Image Lab generates an audit log. Image Lab will not be able to overwrite the secure file, but it can
overwrite the original unsecure file.

Secure Documents
Until ChemiDoc Touch image files created using Image Lab Touch 1.2 or earlier are signed, they are
saved as standard files. Once signed, they are they saved with the secure extension (.sscn).

Note: A secure document can be saved unsigned. Likewise, a signed document can be saved as
a new, unsigned file. In this case, the saved file is still a secure document. All changes to the
document are captured in the document log.

Documents created in secure mode can be signed at any time. When a secure document is signed, it
is saved as read-only. Image Lab cannot overwrite the document. You can open signed documents
and sign them again. The newly signed file is saved as a second revision, and the new signatures are
captured in the document log.

Note: Image Lab can never overwrite a signed file.

You can open secure documents in standard mode of Image Lab. Selecting Save As in the File menu
creates an unsecure file. The original file is preserved, and an entry is added to the original log that
the file has been reverted to unsecure. Image Lab standard edition can modify the file. A log is
generated for the new, unsecure document, and Image Lab no longer checks the file for unauthorized
alterations.
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Modifying Secure Documents
You can open and change a signed document in Image Lab. The original document is read-only and
cannot be overwritten. Saving the revisions opens the Save As dialog box. The changes are saved
into a new revision with an incremental revision number.

Each time a secure document is modified, you must provide a reason for each change before you can
sign the document. The modifications are logged in the document log. The new signed document
takes with it the entire history of the original document in its log.

Signing Documents
To sign a document

1. Select the protocol or results file.

2. In the Security menu, click Sign Document.

The Signing Document dialog box appears.

3. Enter the user name and password of a user authorized to sign documents.

Note: The user name and password can be for a user other than the current user.

4. Enter a reason for signing the document. Typical reasons include review, approval, responsibility,
or authorship.

Note: You must provide a reason in order to sign the document.
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The user name, date and time of the signature, and reason for signing are always included in the
Signature History section of the image report (see General Tab on page 150.

5. Click OK.

A Save File dialog box appears.

6. Enter a new name for the file and click Save.

Note: Signed images are saved with an .sscn extension.

Document Logs
Changes made or actions performed on an image file generate a document log that documents each
change or action. If you change a file and save it as a new file, of whether you are in secure mode or
not, the document log is preserved in the new file. If you are in secure mode, the signature of the
previous file is noted as part of the document log.

All major actions and changes are audited (they generate a document log). Examples of auditable
actions include

n Signing a file

n Changing the image by cropping or rotating it, for example

n Modifying the analysis. For example, changing the lanes and bands or adding or editing
annotations to the images

Minor changes that affect only the display are not audited, such as

n Selecting different columns in the Analysis Table

n Changing the display options in the Lane Profile

n Annotating or labeling the image using Annotation Tools

Each change you make to a signed image file must be documented in the Reason for Change dialog
box.
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Viewing the Document Log
The View menu displays a list of logs for each open document. The document log captures
information about editing image files. You can view the document log for any open file. This file can be
a previously saved file or a newly created image file that is open on your desktop but not yet saved.

If the document was previously saved, the log is identified with its name. If the document has not been
saved, the log is identified with the time stamp that shows when the document was created.

The document log includes

n Date and time

n User

n Level — security role of the user

n Type — type of event

n Description — the actual event captured

n Reason — reason for signing a document

For more information about logs, see Software Logs on page 161.
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Appendix A Regression Calculation Methods
Each regression method calculates a standard curve. Some methods provide the formula for the
standard curve. In this case, the molecular weight can be calculated by

x = relative front of the band of interest

y = molecular weight of the band of interest

Linear (semi-log): The linear equation is y = a + bx, where a is the intercept and b is the slope of the
line.

Note: The linear equation is calculated on the log of the molecular weight values.

The R2 value can be used to determine the overall quality of the linear fit. A linear regression with an
R2 value of >0.99 is considered a very good fit. The primary advantage of this method is that it is
extremely simple. The primary disadvantage is that it will deliver incorrect results if the data are not
very linear.

Point-to-point (semi-log): No single equation is available for the point-to-point method. The slope of
each segment of the curve between data points is calculated independently.

Note: The log of the molecular weight values is used to calculate the slope for each segment of
the curve.

Logistic: The logistic-4PL equation is
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where

x = mobility

y = molecular weight

a = estimated molecular weight at infinity

b = slope of the tangent at midpoint

c = midpoint

d = estimated molecular weight at zero mobility

Since the curve generated by the logistic-4PL regression method represents a perfectly shaped S, it
might not fit the data very well in all cases.

Cubic spline: Cubic spline curves are smooth curves that go through every data point. The model is a
cubic polynomial on each interval between data points. In some cases, a spline curve can work well
as a standard curve for interpolation. However, because the curve is calculated individually for every
pair of points, it does not correspond to any single equation.
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Appendix B Setting Up Users and Groups
This appendix explains how to set up users and groups to run Image Lab Security Edition software in
secure mode.

Note: This task requires System Administrator privileges on the client computers (and possibly
their domain) on which Image Lab is installed.

User Accounts
To give users access to Image Lab, Security Edition, you can create new Windows user accounts, add
existing user accounts to the four default user groups, or rename any of the four default user groups.
Default user groups and roles are defined in User Names, Groups, and Roles on page 172.

n A user account can have any name, but a password must be defined for the account. See
Password Security on page 190 for information about setting passwords for maximum security.

n Each user can belong to the Image Lab Administrator group and one other Image Lab user group.

For example, a user can belong to the Administrator group and the Supervisor group, but a user
cannot belong to both the Clinician group and the Supervisor group.
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User Authentication and Group Membership
In Image Lab authentication consists of two processes: user authentication and group membership
evaluation.

User Authentication

Image Lab matches (authenticates) a user name with permissions assigned to that user name on the
authentication domain. The domain can reside on your local computer (a local domain) or on a
network server (a network domain). If you (or your network administrator) choose a local domain to be
used for authentication, you are considered a local user. If you or your network administrator choose a
network domain, you are considered a domain user.

Group Membership Evaluation

Image Lab verifies that a user is a member of one or more of the four default Image Lab user groups
(TDS_Administrator, TDS_User, TDS_Tech, or TDS_Guest). The valid members for each of these
groups can be specified in one of two places, as defined by the Use local groups for establishing user
security levels checkbox on the Security Preferences dialog box.

When this checkbox is selected, only users and groups that are defined on the local computer (on
which Image Lab is installed) are recognized. When this checkbox is not selected, only users and
groups that are defined on the network domain are recognized.
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Finding Your Authentication Domain Name
Your authentication domain can be hosted on your local computer (a local domain) or on a network
server (a network domain).

To find the name of your local domain

u In Windows, open the Control Panel and click System.

The System window appears.

Under Computer name, domain, and workgroup settings, the name of your local computer is
shown as Computer name.

To find the name of your network domain

u In Windows, open the Control Panel and click System.

The System window appears.

Under Computer name, domain, and workgroup settings, the name of your network domain is
shown as Domain.

Specifying the Domain Name
To specify the domain name

u In the Security Preferences dialog box, enter the exact name of the local computer or network
server you want to designate as the authentication domain.
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Configuring Users and Groups on a Local Computer
To access users and groups settings on a local computer

1. In the Windows Control Panel, select Administrative Tools.

2. Select Computer Management.

3. In the Computer Management window, open the System Tools folder, and then open the Local
Users and Groups folder.

To create a new user on a local computer

1. Open the Users folder and click Action > New User.

The New User dialog box appears.
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2. Enter information about the user in the following boxes:

n User name—must be unique.

n Full name—must be unique. Bio-Rad recommends using the user’s actual full name, as this
name will be shown in the document log and all the log reports. This is a requirement of 21
CFR 11.50a.

n Description— required. Bio-Rad recommends entering the user’s title as the description.

n Password— enter and confirm a password for the user.

n (Optional) To prevent the Windows system administrator from knowing the user's password,
you can select the User must change password at next login checkbox. In this case, the user
must log on to Windows and change the password before using Image Lab Security Edition.
Otherwise, Security Edition will not recognize the user.

To create a new group on a local computer

1. In the Computer Management window, open the Groups folder and select Action > New Group.

The New Group dialog box appears.

2. In the Group name box, enter the name of one of the following default groups: TDS_Administrator,
TDS_User, TDS_Tech, TDS_Guest.
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3. (Optional) Enter a description in the Description box.

The group does not need special operating-system level privileges.

4. Click Create to save the new group.

5. Repeat steps 2–4 to create the remaining groups.

To add a user to a group on a local computer

1. Do one of the following:

n In the New Group dialog box, click Add.

n In the Groups folder, double-click an existing group. In the Properties dialog box that
appears, and click Add.

The Select Users dialog box appears.

2. Click Advanced. The Search results box becomes visible.

3. Click Find Now to populate the Search results box with the names of all local computer users.
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4. To add users to the group, do one of the following:

n Select a user name.

n Select multiple user names: hold down the Ctrl key and select the user names you want.

5. When you have selected all the users to add to the group, do one of the following:

n To save the users to an existing group click OK and then click OK again to close the Select
Users dialog box.

n To create the new group and save the users to it, click Create to close the New Group dialog
box.
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Configuring Users and Groups on a Network Domain
Note: The network administrator must know how users and groups are set up using the Windows
server software at your site. The following example is used to illustrate the choices.

To locate the users and groups on a Windows server

u Open Administrative Tools and select Active Directory.

Note that in the Active Directory window, the Users folder lists groups as well.

To create a new user on a Windows server

1. With the Users folder open, select Action > New User. Alternatively, use the right-click context
menu.

The New User dialog box appears.

2. Fill in all the boxes:

n User name—must be unique.

n Full name—must be unique.

Bio-Rad recommends using the user’s actual full name, as this name will be shown in the
document log and all the log reports. This is a requirement of 21 CFR 11.50a.

n Description— required. Bio-Rad recommends entering the user’s title as the description.

n Password— Enter and confirm a password for the user.

n (Optional) To prevent the Windows system administrator from knowing the user's password, you
can select the User must change password at next login checkbox. In this case, the user must log
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on to Windows and change the password before using Image Lab Security Edition. Otherwise,
Security Edition will not recognize the user.

To create a new group on a Windows server

1. With the Users folder open, select Action > New Group.

2. In the Group name box, enter one of the following group names: TDS_Administrator, TDS_User,
TDS_Tech, TDS_Guest.

Type the name exactly as specified. You can also enter a description for the group in the
Description box.

Note: The group does not need special operating-system level privileges.

To add a user to a group on a Windows server

1. Do one of the following:

n In the New Group dialog box, click Add.

n Double-click an existing group in the User Manager folder to open its Properties dialog box
and click Add.

The Select Users dialog box appears.

2. Click Advanced to expand the dialog box.
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3. Click Find Now to populate Search results with all user names.

4. Click a user name in the list to select it, or press the Ctrl key and click multiple users to select
them.

5. When you have selected all the users to add to the group, do one of the following:

n To save the users to an existing group click OK and then click OK again to close the Select
Users dialog box.

n To create the new group and save the users to it, click Create to close the New Group dialog
box.

Password Security
21 CFR 11.300 (b) requires that passwords be “periodically checked, recalled, or revised.” Password
policies are therefore recommended, although the password duration and rules are up to the system
administrator and the organization. For instance, the exact duration between password changes is
flexible.

To set password policies on a local computer

1. Open the Control Panel and select Administrative Tools > Local Security Policy.

2. In the left pane of the Local Security Policy window, expand Account Policies and then select
Password Policy.

Password policies appear in the right pane.

190 | Image Lab Software



Password Security

3. To change password policy settings:

a. Right-click the policy and select Properties to open its properties dialog box.

b. Modify the default setting to meet your company policy.

c. Click Apply.

d. Click OK to close the Properties dialog box.

4. Close the Local Security Policy window.

To set password policies in Active Directory

1. Open the Control Panel and select Administrative Tools > Domain Controller Security Policy.

2. In the left pane of the Domain Controller Security Policy window, expand Security Settings >
Account Policies and select Password Policy.

3. To change password policy settings:

a. Right-click the policy and select Properties to open its properties dialog box.

b. Modify the default setting to meet your company policy.

c. Click Apply.

d. Click OK to close the Properties dialog box.

4. Close the Domain Controller Security Policy window.
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Password Policy Setting Examples
The following examples are only suggestions. Your organization should establish its own password
policy.

n Enforce password history: 12 passwords remembered

n Minimum password age: 5 days

n Maximum password age: 30 days

n Minimum password length: 8 characters

n Password must meet complexity requirements: Enabled

n Store passwords using reverse encryption: Enabled

Account Lockout Policy Setting Examples
n Account lockout duration: 0 (The account is locked out until the administrator unlocks it.)

n Account lockout threshold: 3 login attempts

n Reset account lockout counter after: 30 minutes

Auditing Windows Event Logs
Some global auditing information is stored in the Windows Event logs. It is a requirement of 21 CFR
Part 11 that these logs be archived. However, by default, Windows systems automatically remove
these data without warning.

Note: It is therefore critical that the event log is reconfigured to generate and preserve all
necessary log data. Regular manual intervention is also required to preserve these data.

To open the Event Properties Log

1. Open Administrative Tools and click Event Viewer.

2. Right-click on each log and select Properties.

3. In the section When maximum event log size is reached: select Do not overwrite events (Clear
logs manually).

4. Increase the maximum size of the event log to cover any possible messages. The smaller the
maximum size of the event log, the more often the system administrator must manually view,
archive, and clear the system log.
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Auditing information generated by the operating system is recorded in the Security Log. Logon failures
in Image Lab Security Edition are recorded in this log.

During the review process, the log should be examined for attempted breaches of security, such as a
series of failed login attempts. To avoid the risk of losing data, the size should be very large and this
inspection/archive process should occur daily. The Audit Policy should be set as follows:

n Audit account login events — Failure should be checked at a minimum

n Audit account management — both Success and Failure should be checked

n Audit login events — Failure should be checked at a minimum

n Audit policy change — both Success and Failure should be checked

Other Security Measures
Bio-Rad recommends that you use the built-in protections that Windows Server offers in order to
protect the computer while the user is absent.

Note: Microsoft continually updates its operating systems in response to security issues. It is
critical to keep all components of the Windows operating system, especially domain controllers,
up to date.
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Appendix C Troubleshooting
Follow these suggestions to troubleshoot your system.

Problem Possible Cause Solution

Camera does
not respond or
camera not
found

n Power to the camera may be turned
off.

n The camera cables may not be
seated properly.

n The software driver for the camera is
missing.

n Computer power-saving modes may
be interfering with the camera driver.

n The cables may be defective.

n The camera may be defective.

n Turn on the power to the camera.

n Make sure that all cables are connected
as shown in the Installation Guide.

n If the camera driver is not present, reload
the camera driver from the Image Lab
software installer.

n Disable the power-saving modes on the
computer.

n Replace the cables.

n Replace the camera.

Image is not
visible on the
monitor

n The monitor settings are incorrect.

n The lens cap is attached.

n See your computer manual for the proper
settings.

n Remove the lens cap.

Printout does
not look like the
monitor image

n The monitor settings are wrong.

n The printer settings are wrong.

n See your monitor manual for the
appropriate settings.

n See your printer manual for the
appropriate settings.

Unable to focus
on the sample
using white
light
transilluminator
or conversion
screen

n Focus is not calibrated for samples
using this light source.

n Select Edit > Instrument Setup to
recalibrate the focus for use with this
accessory.

Troubleshooting tips
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Appendix D Accessories
The following table lists catalog numbers and descriptions for available standards. For more
information, see the Bio-Rad Life Science Research Product Catalog.

Catalog ID Description

Protein Standards

161-0363 Precision Plus Protein Unstained Standards. 1 ml

161-0373 Precision Plus Protein All Blue Standards, 500 µl

161-0374 Precision Plus Protein Dual Color Standards, 500µl

161-0375 Precision Plus Protein Kaleidoscope Standards, 500 µl

161-0385 Precision Plus Protein WesternC pack, 50 applications

161-0396 Precision Plus Protein Unstained Standards (5 pack)

161-0393 Precision Plus Protein All Blue Standards (5 pack)

161-0394 Precision Plus Protein Dual Color Standards (5 pack)

161-0377 Precision Plus Protein Dual Xtra Standards (single vial = 500 µl)

161-0397 Precision Plus Protein Dual Xtra Standards (5 pack)

161-0395 Precision Plus Protein Kaleidoscope Standards (5 pack)

161-0398 Precision Plus Protein WesternC pack (5 pack)

Nucleic Acid Standards

170-8351 EZ Load 20 base pairs molecular ruler

170-8352 EZ Load 100 base pairs molecular ruler

170-8353 EZ Load 100 base pairs PCR molecular ruler

Table 9.
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Catalog ID Description

170-8354 EZ Load 500 base pairs molecular ruler

170-8355 EZ Load 1 kb molecular ruler

170-8205 2.5 kb molecular ruler

170-8200 AmpliSize® molecular ruler

Pulsed Field Standards and Markers

170-3624 CHEF DNA size standard, 5 kb ladder

170-3707 CHEF DNA size standard, 8 - 48 kb

170-3635 CHEF DNA size standard, lambda ladder

170-3605 CHEF DNA size marker, 0.2 - 2.2 Mb

170-3667 CHEF DNA size marker, 1 -3.1 Mb
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Appendix E Mitsubishi P95 Thermal Printer
This appendix describes how to set up a thermal printer in both Windows and Mac environments.

Setting up a Thermal Printer on a Mac
The printer driver can be found on the Image Lab software installation USB drive in the Misc directory.

To set up a thermal printer on a Mac system

1. Install the printer driver.

2. Connect the printer to the computer.

3. Restart the computer.

To configure the correct paper size

1. Start Image Lab software.

2. Select File > Page Setup.

3. In the Settings list, select Page Attributes.

4. In the Format For list, select the Mitsubishi printer.

5. In the Paper Size list, select 1280 x 1280.

6. In the Settings list, select Save as Default.

7. Click OK to save the settings.

For assistance with the printer driver or additional information about the printer, contact
http://www.mitsubishielectric-printing.com.
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Setting up a Thermal Printer on Windows
The printer driver is on the Image Lab software installation USB drive in the Misc folder.

To set up a thermal printer on a Windows system

1. Install the printer driver.

2. Open the printer section in Control Panel.

3. Click the thermal printer icon and select Printing Preferences.

4. Configure the correct paper size. Select 1280 x 1280 from the dropdown list.

5. Click OK to apply your changes.
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Glossary
Aspect ratio The ratio of the width to the height of an image.

Color maps Different color representations of a gel image.

Example
precision

The number of decimal places chosen for displaying a
measurement.

Histogram A graphed representation of the brightness, or gray value, of an
image.

Imager The instrument without Image Lab software.

Imaging system The instrument connected to a computer running Image Lab
software.

Multichannel
image

An image consisting of two or three channel images.

Native charge
density

The inherent electrical charge of a protein without the addition of
SDS.

Rf Relative front value of the band. In Image Lab software, Rf has a
value between 0 and 1 and indicates the relative movement of the
band from top to bottom.
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